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1 Introduction 

1.1 Overview 

The L-INX product family consists of high performance, reliable and secure network 

infrastructure components that implement an embedded automation server. The different 

models of the L-INX family contain a number of components and network technologies. As 

protocols on the control network side, the L-INX implements access to BACnet, CEA-709, 

KNX, Modbus, and M-Bus. The BACnet models are BTL-certified B-BC devices. 

The L-GATE product family is intended for use as universal gateways. They provide a 

similar user interface and set of protocols as the L-INX family. The L-GATE provides data 

access to a defined set of data points, which are mapped from one control network technology 

to another control network technology. In particular, the CEA-709/BACnet Gateway 

(LGATE-902) implements mappings between a set of CEA-709 network variables (NVs) 

and a set of standard BACnet server objects. Which NVs are mapped to BACnet objects can 

be configured by an LNS plug-in or stand-alone configuration software. The LGATE-902 is 

equipped with a 100-BaseT Ethernet port (IP), an FT-10 port (CEA-709), and an RS-485 port 

(MS/TP). The device is fully compliant with ANSI/CEA-709 and ENV14908, 

ANSI/ASHRAE-135-2004 and ISO 16484. The LGATE-95X extends the 902 model with a 

number of additional protocol ports and supports more data points for the gateway. 

Data from the supported network technologies are available as data points in the automation 

server. Those data points are freely configurable via configuration software, which provides 

a fast and easy way to configure the L-INX and L-GATE using online network scans, 

import/export features or device templates. Data points between different network 

technologies can be connected to each other for data transfer between those network 

technologies (gateway). Data points are also subject to alarming, trending and scheduling 

(AST) functions of the automation server. The usage of math objects allows basic 

calculations and the built-in E-mail client allows the L-INX and L-GATE to transmit e-mails 

on certain conditions. Generated alarms can be configured to send e-mails to predefined 

addresses. Alarms can also be stored in a historical alarm log. Trended data collected by the 

device and is available in CSV format and through a dedicated Web service. 

An embedded OPC server exposes a defined set of data points as OPC tags. It implements 

the OPC XML-DA standard OPC XML-DA 1.01, which lets OPC clients access the data 

points via Web services. For secure OPC communication some L-INX models add an OPC 

UA server. Which native data points are exposed to OPC can also be configured by the 

configuration software. AST objects such as schedules are exposed as a set of OPC tags. 

Using the supplied L-WEB designer, users can easily generate a Web-based visualization for 

the L-INX. 

Only the L-INX family contains a freely programmable controller that can operate on all 

L-INX data points. The controller application is developed using the provided IEC-61131 

compliant design tool. 
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The L-INX and the L-GATE permanently collect statistical information from the attached 

network channels (OPC connections, FT traffic, MS/TP token passing, Ethernet traffic, etc.). 

Using this data, the device is able to detect problems on these channels (overload, lost tokens, 

connection problems, etc.) and warns the system operator via LEDs (see Section 6.4). An 

intuitive user interface allows fast and easy network troubleshooting without any additional 

analysis tools or deep system knowledge. For troubleshooting Ethernet protocols a local and 

remote Wireshark packet capture can be configured (see Section 10.2). 

The built-in Web server allows convenient device configuration through a standard Web 

browser such as the Internet Explorer or Firefox. The Web interface also provides statistics 

information for system installation and network troubleshooting. Some devices also have an 

LCD display, which provides a quick way to configure basic settings of the device via a jog 

dial. Also available on some L-INX models are ports for SD card memory and a USB 

peripheral bus. 

Some L-INX and L-GATE models are also equipped with a 2-port Ethernet Switch/Hub. In 

switched mode an Ethernet daisy chain can be built, which reduces cabling effort. The two 

Ethernet connectors can also be configured to work as two isolated IP interfaces. This can be 

used to safely connect a local building network while keeping it isolated from WAN access, 

that exposes some aspects using secure services. By using the external L-WLAN adapter, the 

device also provides a WLAN interface, which can link to an existing access point, set up its 

own access point or work in a wireless mesh network. 

The L-INX is used for: 

• Exposing data of control network devices from different technologies (CEA-709, 

BACnet, KNX, Modbus, M-Bus) to data points in the automation server, 

• Directly connecting I/Os to data points in the automation server, 

• exposing data points to OPC tags, 

• visualization of data points with the supplied LOYTEC L-WEB software, 

• visualization of data points in an OPC XML-DA, UA SCADA package, 

• Room control, plant control running IEC61131 programs on data points, 

• automatic meter reading applications via M-Bus and Modbus, 

• meter gateway to BACnet using pulse counters or M-Bus and Modbus meters, 

• browsing data points on the Web interface or LCD display, 

• basic automation functions on data points (alarming, trending, scheduling), 

• logging alarms, 

• sending e-mails on alarms, trend logs, or scheduled events. 

The L-GATE is used for: 

• Connecting data points between any supported control networks (CEA-709, BACnet, 

KNX, Modbus, M-Bus) using the universal gateway function, 

• browsing data points on the Web interface or LCD display, 

• exposing data points to OPC tags, 

• basic automation functions on data points (alarming, trending, scheduling), 

• logging alarms, 

• sending e-mails on alarms, trend logs, or scheduled events, 

• gateway for ANSI/CEA-709 network variables (NVs) and configuration properties 

(CPs), 

• gateway for standard (SNVT, SCPT) and user-defined (UNVT, UCPT) types. 
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1.2 CEA-709.1 

L-INX automation server models that have CEA-709 and all L-GATE models are equipped 

with an FT port (CEA-709) and a 100Base-T Ethernet port (CEA-852). CEA-709 L-INX 

models come with a router option or an RNI option. L-INX models with the router option 

contain a CEA-709 router between the FT and the IP-852 channel, which can be configured 

like an L-IP. It includes a configuration server (CS) to manage the IP-852 channel. The 

L-INX models without the router option contain a remote network interface (RNI) instead of 

the router for remote network access. Please refer to Table 1 to learn, which device models 

have CEA-709 and the router option. 

The CEA-709 L-INX and L-GATE device is fully compliant with ANSI/CEA-709, 

ANSI/CEA-852-A, EN 14908. The CEA-709 node, that is going to be commissioned in the 

network, is always connected to the FT port of the device. 

The function of the CEA-709 node is to expose CEA-709 network variables (NVs) and 

configuration properties (CPs) to data points in the automation server or the gateway. The 

configuration software can be run as LNS plug-in or stand-alone. The CEA-709 data points 

can be bound in the CEA-709 network as NVs or operated as “external NVs”. External NVs 

are polled or explicitly written to without allocating static or dynamic NVs on the device. In 

this case, address information is supplied by the configuration software by importing e.g., a 

CSV file. User-defined network variable types (UNVTs) can be used as dynamic or external 

NVs. Configuration properties (CPs) on other devices can be accessed through file transfer. 

To transfer CPs, the device supports both the LONMARK file transfer and the read memory 

access method. For CPs, the standard SCPTs and user-defined UCPTs are supported. All 

those CEA-709 data points can be exposed to the automation server or the gateway. 

The CEA-709 L-INX with the router option possesses a router between the CEA-852 

interface (IP-852) and the FT interface. The CEA-852 interface can be used to connect the 

L-INX to an IP-based high-speed backbone. The L-INX’s router can be used as a standard 

CEA-709 configured router or it can be used as a self-learning plug&play router based on the 

high-performance, well-proven routing core from our L-Switch plug&play multi-port router 

devices (“smart switch mode”). The self-learning router doesn’t need a network management 

tool for configuration but is a true plug&play and easy to use IP infrastructure component. 

For a detailed description of the CEA-709 router’s usage refer to the L-IP User Manual [8]. 

The L-GATE and the CEA-709 L-INX without the router option can be configured to run 

either on the CEA-852 interface (IP-852 mode) or on the FT interface (FT mode). In the FT 

mode, the device provides a remote network interface (RNI), which appears like a LOYTEC 

NIC-IP is intended to be used together with the LOYTEC NIC software [3]. The RNI can be 

utilized for remote access and configuration as well as trouble-shooting with the remote LPA. 

Please consult our product literature for the LPA-IP to learn more about this IP-based 

CEA-709 protocol analyzer. 

The CEA-709 technology in the L-INX and L-GATE allows for: 

• Exposing CEA-709 network variables (NVs) and configuration properties (CPs) as data 

points to the automation server or gateway, 

• supporting standard (SNVT, SCPT) and user-defined (UNVT, UCPT) types, 

• scheduling CEA-709 network variables, 

• generating alarms over the LONMARK node object, 

• CEA-709 PC applications (as a CEA-709 network interface), 

• remote LPA functionality, 

• communicating on CEA-709 with either FT or IP-852 (IP channel on the 

Intranet/Internet), 
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• connecting an FT channel to a high-performance backbone using existing IP infra-

structure, 

• operating as a configuration server for IP-852 devices with the router option. 

1.3 BACnet 

L-INX automation server models that have BACnet and all L-GATE models are BTL-

certified products that implement the B-BC profile. They are equipped with an MS/TP port 

and a 100Base-T Ethernet port (BACnet/IP and/or BACnet/SC). The MS/TP port supports 

remote Wireshark packet capture for troubleshooting. BACnet L-INX models with the router 

option also contain a BACnet router between the MS/TP and the BACnet/IP and BACnet/SC 

ports, which can be configured like an LIP-ME20X. The router models also include a BACnet 

broadcast management device (BBMD) to manage BACnet/IP internetworks, which span 

across IP routers. BACnet models without the router can register as a foreign device (FD) 

with other BBMDs. The device is fully compliant with ANSI/ASHRAE 135-2020 (Rev 1.16) 

and ISO 16484-5. Please refer to Table 1 to learn, which device models have BACnet and 

the router option. 

The BACnet L-INX and the L-GATE expose BACnet server objects and client mappings to 

data points of the automation server or the gateway. For client mappings, the BACnet address 

information is supplied by the configuration software by importing e.g., a CSV file or by 

performing an online network scan. 

The BACnet L-INX  and L-GATE models also support the LOYTEC Alarming, Scheduling 

and Trending (AST) features in native BACnet objects. The device provides BACnet 

scheduler/calendar objects, which can directly schedule BACnet server objects, remote 

BACnet objects or non-BACnet registers. For alarm conditions the device supports the 

intrinsic reporting method of BACnet objects. Trend logs can be uploaded from the device 

via the native BACnet read range. 

The BACnet L-INX with the router option possesses a BACnet router between the 

BACnet/IP port, the BACnet/SC port, and the MS/TP port. This router can be operated and 

configured like the LIP-ME20X from LOYTEC. The BACnet/IP or BACnet/SC interface 

can be used to connect the L-INX to an IP-based high-speed backbone. The L-INX also can 

act as a BBMD for a BACnet/IP network. For a detailed description of the BACnet router’s 

usage refer to the LIP-ME20X User Manual [9]. 

A BACnet L-INX without the router option and the L-GATE can be configured to run either 

on the BACnet/IP or on the BACnet/SC or on the MS/TP interface. In BACnet/IP mode, the 

L-INX can be configured as a foreign device in another BBMD. The BACnet L-INX without 

the router option does not provide the BBMD functionality itself. The L-GATE can also be 

configured to be a BBMD. Please refer to Table 1 to learn, which models can be configured 

as a BBMD. 

The BACnet technology in the L-INX and L-GATE allows for: 

• Using the device as a BTL-certified B-BC, 

• exposing local BACnet server objects (analog, binary, multi-state) and remote objects 

(client mappings) to data points, 

• scheduling any data point from native BACnet schedule and calendar objects, 

• trending any data point to native BACnet trend log objects, 

• generating native BACnet alarms on any data point, 

• communicating with either MS/TP, BACnet/IP, or BACnet/SC, 

• connecting an MS/TP network to a high-performance backbone using existing IP infra-

structure, 



L-INX/L-GATE User Manual 13 LOYTEC  

Version 8.4  LOYTEC electronics GmbH 

• operation as a BBMD for a BACnet/IP network with the router option, 

• troubleshoot the MS/TP network with Wireshark remote packet capture (see Section 

10.2), 

• distributing NTP time into the BACnet network as BACnet time master. 

1.4 M-Bus 

In addition to the basic network technologies all models except the LGATE-900 support the 

M-Bus interface according to the standards EN 13757-2 and EN 13757-3. To get access to 

the M-Bus network, an external M-Bus interface such as the L-MBUS by LOYTEC must be 

attached to the device. On devices with a serial port, the M-Bus interface is connected to the 

serial connector. In this case the user needs to turn M-Bus support on and off via a DIP 

switch. On devices without a serial port, the L-MBUS interface must be used and is connected 

to the extension port (EXT). 

Through the M-Bus interface the L-INX can be used to scan the attached M-Bus network for 

devices, pull M-Bus data points into a configuration, connect those data points to other 

technologies and expose M-Bus data points to the automation server. All AST functions can 

be used directly on M-Bus data points. Especially trending data and polling for data on M-

Bus devices has been optimized for automatic meter reading applications. 

For debugging purposes a protocol analyzer is included in the firmware and can be operated 

via the Web-UI and the configuration software. For more information on how to set up the 

device for using M-Bus, configuring and using M-Bus data points, refer to the M-Bus Chapter 

in the LINX Configurator User Manual [2]. 

1.5 Modbus 

In addition to the basic network technologies the all models support the Modbus RTU and 

the Modbus TCP interface. To get access to the Modbus network, the appropriate interfaces 

have to be activated either in the Web UI or in the configuration software. Modbus RTU is 

operated with 8N1. A Modbus port can either be operated as Modbus master or Modbus 

slave. 

On some BACnet L-INX models, the Modbus RTU and BACnet MS/TP protocols share the 

same port. On those models, Modbus RTU can only be used, if BACnet MS/TP is disabled. 

Please refer to Table 1 to learn, which BACnet L-INX models have this restriction. 

Using the LRS232-802 interface extends a LOYTEC device by two RS-232 ports over the 

USB connector. Modbus ASCII or RTU can be operated on those RS-232 extension ports 

where RS-232 cennectivity is required. 

Through the Modbus interface the device can be used to data points to other technologies, 

and expose Modbus data points to OPC tags. All AST functions can be used directly on 

Modbus data points. Especially trending data and polling for data on Modbus devices has 

been optimized for automatic meter reading applications. 

For debugging purposes a protocol analyzer is included in the firmware and can be operated 

via the Web UI and the configuration software. For more information on how to set up the 

device for using Modbus, configuring and using Modbus data points, refer to the Modbus 

Chapter in the LINX Configurator User Manual [2]. 
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1.6 KNX 

In addition to the basic network technologies, some L-INX and L-GATE models can be 

connected to KNX networks (see Section 1.12). To gain access to a KNX TP1 network, the 

LKNX-300 interface has to be attached to the device for TP1 networks. All KNX-capable 

models support KNXnet/IP directly with their Ethernet interface. 

The KNX interface allows creating KNX data points which can be used with the AST 

functions, the OPC server and also the PLC on the L-INX models. The device configuration 

can be imported from an ETS database export. 

For more information on how to set up the device for using KNX, configuring and using 

KNX data points, refer to the KNX Chapter in the LINX Configurator User Manual [2]. 

1.7 EnOcean 

In addition to the basic network technologies, some L-INX and L-GATE models can integrate 

EnOcean wireless devices (see Section 1.12). To gain access to an EnOcean network, the 

LENO-800 interface has to be attached via one of the USB ports USB 1 or USB 2. 

The EnOcean interface is represented in the Configurator as a technology folder. EnOcean 

devices are created from device templates and provide data points, which can be used with 

the AST functions, the OPC server and also the PLC on the L-INX models. 

For debugging purposes a protocol analyzer is included in the firmware and can be operated 

via the Web UI. For more information on how to set up the device for using EnOcean, 

configuring and using EnOcean data points, refer to the EnOcean Chapter in the LINX 

Configurator User Manual [2]. 

1.8 SMI 

In addition to the basic network technologies, some L-INX and L-GATE models can be 

connected to SMI networks (see Section 1.12). To get access to the SMI network, the 

LSMI-800 interface has to be attached to the EXT port of the device (for one SMI channel), 

or the LSMI-804 interface to the USB port (for four SMI channels). LOYTEC devices 

support SMI 3.0 BF (basic format). 

The SMI interface is represented in the Configurator as a technology folder. SMI devices are 

created from device templates and provide data points, which can be used with the AST 

functions, the OPC server and also the PLC on the L-INX models. 

For debugging purposes a protocol analyzer is included in the firmware and can be operated 

via the Web UI. For more information on how to set up the device for using SMI, configuring 

and using SMI data points, refer to the SMI Chapter in the LINX Configurator User Manual 

[2]. 

1.9 MP-Bus 

In addition to the basic network technologies, some L-INX and L-GATE models can be 

connected to MP-Bus networks (see Section 1.12). To get access to the MP-Bus network, the 

LMPBUS-804 interface has to be attached to the built-in USB ports USB 1 and USB 2. Up 

to two LMPBUS-804 interfaces can be operated at the same time, covering a maximum of 8 

MP-Bus channels. External USB hubs are not supported. 
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The MP-Bus interface is represented in the Configurator as a technology folder. MP-Bus 

devices are created from device templates and provide data points, which can be used with 

the AST functions, the OPC server and also the PLC on the L-INX models. 

For debugging purposes a protocol analyzer is included in the firmware and can be operated 

via the Web UI. For more information on how to set up the device for using MP-Bus, 

configuring and using MP-Bus data points, refer to the MP-Bus Chapter in the LINX 

Configurator User Manual [2]. 

1.10 L-IOB 

The L-INX automation server models allow connecting physical I/Os to the device via the 

L-IOB I/O modules (see Table 1). On some models those modules can be stacked up directly 

to the L-INX using the LIOB-Connect feature (see Section 1.12). The connected I/O modules 

are automatically identified and coupled as data points into the L-INX automation server. All 

L-INX models also support easy integration of L-IOB I/O modules over FT cabling using the 

LIOB-FT feature, or over Ethernet using the LIOB-IP feature. 

L-IOB modules are available with digital inputs and outputs, analog inputs and outputs and 

universal inputs that are configurable. Some models are also available with a differential 

pressure sensor. 

The I/O modules can be parameterized over the configuration software or the Web UI. All 

parameterization data is stored on the L-INX and can be reloaded to the LIOB modules when 

needed. The exchange of modules is detected automatically. For more information on how 

to setup and use L-IOB I/Os please refer to the L-IOB I/O module user manual [7]. 

1.11 Scripting 

Select programmable L-INX and L-GATE models provide a JavaScript-based scripting 

engine (see Table 1 and Table 2). On some of them, a license (L-IOT1) needs to be purchased 

to enable the feature. The script engine allows users to implement custom protocols using 

RESTful APIs, JSON, Web services for IoT integration into the LOYTEC data point model. 

The dpal-js API gives JavaScript modules access to the data point server. Script modules are 

embedded into and deployed along with the data point configuration. 

The Web interface of the LOYTEC device offers an overview of installed script modules and 

allows starting scripts in debug mode. The debug mode implements the inspector interface 

of Google Chrome to debug JavaScript on the device. For more information read the new 

Scripting Chapter in the LINX Configurator User Manual [2]. 

Node-RED™ is also available on LOYTEC devices with script support. The Node-RED™ 

editor is fully integrated in the Web interface. With Node-RED™ it is a simple task to use 

published nodes and palettes for various tasks, such as REST APIs, MQTT, circadian light, 

etc. There is also a built-in LOYTEC palette that provides nodes for reading and writing data 

points on the device. This combination makes it easy to integrate various IoT components on 

the LOYTEC device. 

1.12 L-INX and L-GATE Models 

This Section provides an overview of the different L-INX and L-GATE models in Table 1 

and Table 2. This table identifies the different features of those models. Models that possess 

a certain feature have a check mark (✓) in the respective column. If a feature is not available 

in the particular model, the column is left blank. 
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L-INX models with the router option have a CEA-709 router or a BACnet router, 

respectively. The LINX-151 has both a CEA-709 router between FT and IP and a BACnet 

router between MS/TP and IP. 

On L-INX models without the router option and on all L-GATE models, certain ports can 

only be used alternatively. On models with CEA-709 this means either as CEA-709 FT or as 

CEA-852 IP (see note 1 in Table 1 and Table 2). On models with BACnet this means either 

as BACnet MS/TP or as BACnet IP (see note 2 in Table 1 and Table 2). Some BACnet 

models have a restriction on Modbus RTU and BACnet MS/TP as they share the same port. 

On those models Modbus RTU can only be used, if BACnet MS/TP is disabled (see note 3 

in Table 1 and Table 2). 

The LGATE-951 has two EXT ports and therefore can operate M-Bus and KNX TP1 at the 

same time, while the LGATE-950 can use etiher M-Bus or KNX TP1. The LGATE-952 has 

two RS-485 and three EXT ports. 
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                  Model 

 

  

Features L
IN

X
-1

0
2
 

L
IN

X
-1

0
3
 

L
IN

X
-1

1
2
 

L
IN

X
-1

1
3
 

L
IN

X
-1

2
0
 

L
IN

X
-1

2
1
 

L
IN

X
-1

5
0
 

L
IN

X
-1

5
1
 

L
IN

X
-1

5
3
 

L
IN

X
-1

5
4
 

CEA-709 Router  ✓  ✓  ✓  ✓ ✓  

CEA-709 RNI ✓  ✓  ✓  ✓  ✓  

CEA-709 (FT) ✓
1 ✓ ✓

1 ✓ ✓
1 ✓ ✓

1 ✓ ✓  

CEA-852 (IP) ✓
1 ✓ ✓

1 ✓ ✓
1 ✓ ✓

1 ✓ ✓ ✓ 

BACnet Router        ✓ ✓ ✓ 

BACnet MS/TP       ✓
2 ✓ ✓ ✓ 

BACnet IP and SC       ✓
2 ✓ ✓ ✓ 

BBMD        ✓ ✓ ✓ 

Modbus RTU ✓ ✓ ✓ ✓ ✓ ✓ ✓
3 ✓

3 ✓ ✓ 

Modbus IP ✓ ✓ ✓ ✓ ✓ ✓ ✓ ✓ ✓ ✓ 

M-Bus ✓
4 ✓

4 ✓
4 ✓

4 ✓
4 ✓

4 ✓
4 ✓

4 ✓
4  

SMI ✓
4 ✓

4 ✓
4 ✓

4 ✓
4 ✓

4 ✓
4 ✓

4 ✓
4  

KNX TP1 ✓
4 ✓

4 ✓
4 ✓

4 ✓
4 ✓

4 ✓
4 ✓

4 ✓
4  

KNX IP ✓ ✓ ✓ ✓ ✓ ✓ ✓ ✓ ✓  

EnOcean ✓
5 ✓

5 ✓
5 ✓

5 ✓
5 ✓

5 ✓
5 ✓

5 ✓
5  

MP-Bus (8 channels) ✓
5 ✓

5 ✓
5 ✓

5 ✓
5 ✓

5 ✓
5 ✓

5 ✓
5  

LRS232-802 ✓ ✓ ✓ ✓     ✓ ✓ 

OPC XML-DA ✓ ✓ ✓ ✓ ✓ ✓ ✓ ✓ ✓ ✓ 

OPC UA ✓ ✓ ✓ ✓ ✓ ✓ ✓ ✓ ✓ ✓ 

OPC Client ✓ ✓ ✓ ✓ ✓ ✓ ✓ ✓ ✓ ✓ 

SNMP ✓ ✓ ✓ ✓ ✓ ✓ ✓ ✓ ✓ ✓ 

PLC (L-LOGICAD)   ✓ ✓ ✓ ✓ ✓ ✓ ✓
6 ✓

6 

PLC (L-STUDIO)   ✓
6 ✓

6     ✓ ✓ 

LIOB Connect ✓ ✓ ✓ ✓ ✓ ✓ ✓ ✓ ✓  

LIOB FT + IP ✓ ✓ ✓ ✓ ✓ ✓ ✓ ✓ ✓ ✓ 

LCD Display ✓ ✓ ✓ ✓ ✓ ✓ ✓ ✓ ✓ ✓ 

SD Card     ✓ ✓ ✓ ✓   

USB ✓ ✓ ✓ ✓ ✓ ✓ ✓ ✓ ✓ ✓ 

Ethernet Switch/Hub ✓ ✓ ✓ ✓ ✓ ✓ ✓ ✓ ✓ ✓ 

WLAN, LTE ✓
5 ✓

5 ✓
5 ✓

5 ✓
5 ✓

5 ✓
5 ✓

5 ✓
5 ✓

5 

SSH, HTTPS, Firewall ✓ ✓ ✓ ✓ ✓ ✓ ✓ ✓ ✓ ✓ 

Script Support ✓
6 ✓

6 ✓ ✓     ✓ ✓ 

1 This model can be configured to have either FT or IP active for CEA-709. 

2 This model can be configured to have either MS/TP or IP or SC active for BACnet. 

3 Modbus RTU can only be used, if BACnet MS/TP is not active on this model. 

4 M-Bus, SMI and KNX TP1 can be used alternatively only on this model. To operate these protocols 

an expansion module is needed and must be ordered separately. LSMI-804 can be connected 
independently. 

5 To operate these protocols an expansion module is needed and must be ordered separately. 

6 These models require a separate license that needs to be purchased to use this feature. Note, that for 
devices since production week 50/2023 (A64 models) the L-LOGICAD license is no longer available. 

Table 1: Available features in different L-INX and L-GATE models. 
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                  Model 

 

  

Features L
IN

X
-2

0
2
 

L
IN

X
-2

0
3
 

L
IN

X
-2

1
2
 

L
IN

X
-2

1
3
 

L
IN

X
-2

1
5
 

L
IN

X
-2

2
0
 

L
IN

X
-2

2
1
 

L
G

A
T

E
-9

0
2
 

L
G

A
T

E
-9

5
0
 

L
G

A
T

E
-9

5
1
 

L
G

A
T

E
-9

5
2
 

CEA-709 Router     ✓       

CEA-709 RNI     ✓   ✓ ✓ ✓ ✓ 

CEA-709 (FT)     ✓   ✓
1 ✓

1 ✓
1 ✓

1 

CEA-852 (IP)     ✓   ✓
1 ✓

1 ✓
1 ✓

1 

BACnet Router  ✓  ✓ ✓ ✓ ✓     

BACnet MS/TP ✓
2 ✓ ✓

2 ✓ ✓ ✓ ✓ ✓
2 ✓

2 ✓
2 ✓

2 

BACnet IP and SC ✓
2 ✓ ✓

2 ✓ ✓ ✓ ✓ ✓
2 ✓

2 ✓
2 ✓

2 

BBMD  ✓  ✓ ✓ ✓ ✓ ✓ ✓ ✓ ✓ 

Modbus RTU ✓
3 ✓

3 ✓
3 ✓

3 ✓ ✓ ✓ ✓
3 ✓ ✓

3 ✓ 

Modbus IP ✓ ✓ ✓ ✓ ✓ ✓ ✓ ✓ ✓ ✓ ✓ 

M-Bus ✓
4 ✓

4 ✓
4 ✓

4 ✓
4 ✓

4 ✓
4 ✓

4 ✓
4 ✓

4 ✓
4 

SMI ✓
4 ✓

4 ✓
4 ✓

4 ✓
4 ✓

4 ✓
4 ✓

4 ✓
4 ✓

4 ✓
4 

KNX TP1 ✓
4 ✓

4 ✓
4 ✓

4 ✓
4 ✓

4 ✓
4 ✓

4 ✓
4 ✓

4 ✓
4 

KNX IP ✓ ✓ ✓ ✓ ✓ ✓ ✓ ✓ ✓ ✓ ✓ 

EnOcean ✓
5 ✓

5 ✓
5 ✓

5 ✓
5 ✓

5 ✓
5 ✓

5 ✓
5 ✓

5 ✓
5 

MP-Bus (8 channels) ✓
5 ✓

5 ✓
5 ✓

5 ✓
5 ✓

5 ✓
5 ✓

5 ✓
5 ✓

5 ✓
5 

LRS232-802 ✓ ✓ ✓ ✓ ✓   ✓   ✓ 

OPC XML-DA ✓ ✓ ✓ ✓ ✓ ✓ ✓ ✓ ✓ ✓ ✓ 

OPC UA ✓ ✓ ✓ ✓ ✓ ✓ ✓ ✓ ✓ ✓ ✓ 

OPC Client ✓ ✓ ✓ ✓ ✓ ✓ ✓ ✓ ✓ ✓ ✓ 

SNMP ✓ ✓ ✓ ✓ ✓ ✓ ✓ ✓ ✓ ✓ ✓ 

PLC (L-LOGICAD)   ✓ ✓ ✓
6 ✓ ✓     

PLC (L-STUDIO)   ✓
6 ✓

6 ✓       

LIOB Connect ✓ ✓ ✓ ✓ ✓ ✓ ✓     

LIOB FT + IP ✓ ✓ ✓ ✓ ✓ ✓ ✓     

LCD Display ✓ ✓ ✓ ✓ ✓ ✓ ✓ ✓ ✓ ✓ ✓ 

SD Card      ✓ ✓  ✓ ✓  

USB ✓ ✓ ✓ ✓ ✓ ✓ ✓ ✓ ✓ ✓ ✓ 

Ethernet Switch/Hub ✓ ✓ ✓ ✓ ✓ ✓ ✓ ✓ ✓ ✓ ✓ 

WLAN, LTE ✓
5 ✓

5 ✓
5 ✓

5 ✓
5 ✓

5 ✓
5 ✓

5 ✓
5 ✓

5 ✓
5 

SSH, HTTPS, Firewall ✓ ✓ ✓ ✓ ✓ ✓ ✓ ✓ ✓ ✓ ✓ 

Script Support ✓
6 ✓

6 ✓ ✓ ✓   ✓   ✓ 

1 This model can be configured to have either FT or IP active for CEA-709. 

2 This model can be configured to have either MS/TP or IP or SC active for BACnet. 

3 Modbus RTU can only be used, if BACnet MS/TP is not active on this model. 

4 M-Bus, SMI and KNX TP1 can be used alternatively only on this model. To operate these protocols an 
expansion module is needed and must be ordered separately. LSMI-804 can be connected independently. 

5 To operate these protocols an expansion module is needed and must be ordered separately. 

6 These models require a separate license that needs to be purchased to use this feature. Note, that for 

devices since production week 50/2023 (A64 models) the L-LOGICAD license is no longer available. 

Table 2: Available features in different L-INX and L-GATE models (continued). 
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1.13 Scope 

This document covers L-INX and L-GATE devices with firmware version 8.4 and describes 

specific functions of those device models. Basic device operations are covered in the 

LOYTEC Device User Manual [1] and data point configuration is covered by the L-INX 

Configurator User Manual [2]. The usage of logiCAD itself is beyond the scope of this 

manual. Please refer to the logiCAD online help in case of additional questions. 
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2 Disclaimer Cyber Security 

LOYTEC offers a portfolio of products, solutions and systems with cyber security functions 

that enable the secure operation of devices, systems and networks in the field of building 

automation and control technology. To ensure that devices, systems, and networks are always 

protected against online threats, a holistic security concept is required that is implemented 

using the latest technology and is being kept up-to-date. The LOYTEC portfolio is only one 

component of such an overall concept. 

The customer is responsible for preventing unauthorized access to the devices, systems and 

networks. These should only be connected to a network or the Internet if adequate security 

measures are in place (e.g. firewalls, separate networks) and a connection is required for 

operation. In addition, LOYTEC’s recommendations for securing devices in the Security 

Hardening Guide (Chapter 12) must be followed. For additional information, please contact 

your support person at LOYTEC or visit our website. 

LOYTEC is constantly working on improving the existing products in order to follow the 

latest cyber security standards. Therefore, LOYTEC strongly recommends installing updates 

as soon as they become available and always using the latest software versions. LOYTEC 

explicitly points out that using older versions or refraining from updates increases the risk of 

online security threats. 
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3 Safety Instructions 

 

ATTENTION 

General Safety Instructions 

Please regard the following general instructions for project planning and 

execution: 

• Regard all measures or prohibitions of the respective country to avoid 

danger of electricity and high voltage. 

• Other relevant regulations of the respective country. 

• House installation regulations of the respective country. 

• Regulations of the utility company. 

• Any specifications, diagrams, dispositions, cable lists and regulations 

of the customer or system integrator. 

• Any third-party regulations (e.g., general contractor or client). 

 

 

ATTENTION 

Country-specific Safety Regulations 

Failure to observe country-specific safety regulations can lead to property 

damage and personal injury. Therefore, comply with the country-specific 

regulations and the corresponding safety guidelines. 

 

 

CAUTION 

Electrical Safety 

Essentially, electrical safety in building automation systems from LOYTEC 

is based on the use of extra-low voltage and safe isolation from mains 

voltage. 

 

 

CAUTION 

IEC (SELV, PELV) (world-wide) 

Depending on the extra-low voltage earthing (24VAC), this results in an 

application according to SELV or PELV in accordance with IEC 60364-4-

41: 

• Ungrounded = SELV (Safety Extra Low Voltage), 

• Earth ground = PELV (Protected Extra Low Voltage). 
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CAUTION 

NEC (North America) 

Class 2 transformers with energy limitation to 100 VA or Class 2 circuits 

with max. 100 VA (using a non-energy-limiting transformer of max. 400VA) 

combined with overcurrent limits (T-4A fuses) can be used for each 

individual 24VAC device. Several fuses for several isolated secondary 

circuits per transformer are possible. The same applies to power supplies 

with 24VDC. 

 

 

CAUTION 

Device Safety 

Device safety is guaranteed by supply with low voltage 24VAC or 24VDC 

and a double insulation between mains voltage 230VAC, 24VAC circuits 

and the housing or by supply via Power over Ethernet (PoE Class 1). In 

addition, the specific regulations for electrical wiring according to this 

manual must be observed. 

 

 

ATTENTION 

Installation Personnel 

Only qualified staff may carry out electrical installations. 

 

 

CAUTION 

Installation according to Safety Class II 

LOYTEC devices, which are designed in compliance with safety class II, 

must be mounted accordingly. 

The following requirements apply:  

• Protection against electric shock has to be ensured by an appropriate 

enclosure. 

• Ensure proper working cable relief for installation in safety class II 

equipment. 

 

 

ATTENTION 

Environment Conditions 

LOYTEC devices have to be installed in a dry and clean environment. In 

addition the permissible environment conditions specified in the product data 

sheet must be observed. 
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CAUTION 

Earth Ground of  (System Zero AC/DC 24V) 

The following items must be observed when earth-grounding system zero 

24VAC:  

• In principle, both earth-grounding and non-grounding of system zero 

of the operating voltage 24VAC is permitted. Important are the local 

regulations and customs. Due to functional requirements, earth ground 

may be necessary or inadmissible. 

• It is recommended to ground 24VAC systems unless this contradicts 

the manufacturer’s instructions. 

• To avoid earth loops, systems with PELV may only be connected to 

earth ground at one point in the system. Unless otherwise stated, 

usually at the transformer. 

• The same applies to 24VDC power supplies. 

 

 

CAUTION 

Functional Earth  

Functional earth must be connected to the building’s protective earthing (PE) 

system on the installation side. 

 

 

CAUTION 

Operating Voltage 24V AC/DC 

The power supply must meet the requirements for SELV or PELV. Permitted 

deviation of the nominal voltage: 

• At the transformer or power supply: 24V AC/DC -10 … + 10% 

• At the device: 24V AC or DC ±10 % 

 

 

CAUTION 

Specification for 24VAC Transformers 

IEC: safety transformers according to IEC 61558 with double insulation, 

designed for 100% duty cycle to supply SELV or PELV circuits. 

U.S.: Class 2 circuits according to UL 5085-3. 

For efficiency reasons, the power drawn from the transformer should be at 

least 50% of the nominal load. 

The nominal power of the transformer must be at least 25 VA. Using a 

transformer of smaller size, the ratio of open circuit voltage to voltage at full 

load becomes unfavorable (> + 20%). 
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CAUTION 

Specification for 24VDC Power Supplies 

Power supplies must be designed for 100% duty cycle to supply SELV or 

PELV circuits. 

U.S.: Class 2 circuits according to UL 5085-3. 

For efficiency reasons, the power drawn from the power supply should be at 

least 50% of the nominal load. 

 

 

CAUTION 

Protection of the 24VAC Supply Voltage 

Transformers must be protected on the secondary circuit, according to the 

transformer dimensions and the effective load of all connected devices: 

Always protect the 24VAC conductor (system potential), 

Additionally protect the conductor  (system zero) where required. 

 

 

CAUTION 

Protection of the 24VDC Supply Voltage 

24VDC power supplies must be short-circuit proof or have an internal 

microfuse. 

Local regulations must be observed. 

 

 

CAUTION 

Protection of Mains Voltage 

Transformers/24VDC power supplies must be protected on the primary 

circuit using a control cabinet fuse. 

 

 

CAUTION 

Power over Ethernet (PoE) 

LPAD-7 Touch Panels require a PoE Class 1 power supply (max. 12W), 

which must be compliant to IEEE 802.3at-2009. 

For the power supply of the PoE switches observe the manufacturer’s 

specifications. 
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CAUTION 

Device Installation/Removal in De-Energized State Only 

Ensure that the power supply is switched off before starting to install or 

uninstall LOYTEC devices. Do NOT connect or disconnect equipment with 

power switched on, unless instructed otherwise. Do NOT assemble or 

disassemble devices with power switched on, unless instructed otherwise. 

 

 

CAUTION 

Power Supply Protection 

When installing LOYTEC devices, ensure that the power source is 

adequately protected by means of a suitably-rated fuse or thermal circuit 

breaker. 

 

 

CAUTION 

Power Supply Voltage 

Do not connect a voltage supply greater than the specified maximum rating. 

Refer to product label and/or datasheet for the correct voltage. 

 

 

CAUTION 

DALI is FELV (Functional Extra Low Voltage) 

A DALI-line is treated to be FELV. Since it is non-SELV the relevant 

installation regulations for low voltage apply. 

 

 

ATTENTION 

DALI Wiring 

A DALI-line may be installed within the same cable or as single conductors 

within the same tube as mains supply. The DALI-line is either limited to a 

maximum length of 300 m using a minimum cross-section of 1.5 mm2 

(AWG15) or it must be ensured that the voltage drop on the DALI-line does 

not exceed 2 V. 
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CAUTION 

Attention to External Voltages 

Any kind of introduction or spreading of dangerous voltages onto the low-

voltage circuits of the system (e.g. due to incorrect wiring) must be avoided 

at any circumstance and represents an immediate life danger or can lead to 

the entire or partial destruction of the building automation system. 
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4 What’s New in L-INX/L-GATE 

4.1 New in L-INX/L-GATE 8.4.0 

Enhanced Account Security and View Role 

The built-in user accounts (admin, operator, guest) can be disabled to prevent attacks on those 

well-known accounts. The admin account can only be disabled, if a custom user account with 

the superadmin role is created instead. For all accounts, the default settings enforce the use 

of strong passwords. 

The new “view” role has been added that allows a user to view configuration settings only. 

A view user cannot change any configuration settings. 

Responsive Web UI 

The Web UI on LOYTEC devices has been enhanced for display on smaller screens such as 

mobile devices or handhelds. The menu structure collapses in order to save space. Some 

pages also provide a responsive display to enhance user experience on smaller displays, such 

as the data point page or Bluetooth commission page. 

 

Figure 1: Responsive Web UI on the data point page. 

Support placeholder %{folder_descr} in Data Point Description 

A new placeholder has been introduced that can be used in data point descriptions. The 

%{folder_descr} is expanded to the actual description text set on the parent folder. This can 

be used to create unique descriptions in CAT instances. 

Increased BACnet Limits 

The limit of BACnet server objects has been extended to allow a larger limit for server objects 

generated by the L-STUDIO logic application. While the general-purpose limit remains the 

same, server objects created by L-STUDIO for the PLC in CAT instances are counted on top 

until the higher limit is reached. This new limit is noted as “incl. PLC” in the tables of Section 

13.2. 
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Also, the limit of the BACnet description property has been increased to hold up to 255 

characters. 

BACnet/SC Node Improvements 

The LOYTEC BACnet/SC node has been extended to improve troubleshooting and 

compatibility with third-party hubs. The node now supports uploading a CA certificate chain. 

While not required by the standard, this feature gives extra flexibility with certain PKI 

implementations. 

The BACnet/SC node also supports a Wireshark interface, that can be enabled for 

troubleshooting the encrypted traffic. On the network, IPv6 is supported for hub connections. 

Support new BT Mesh Device Templates 

The Bluetooth Mesh technology now supports a flexible concept for generalized device 

templates. Using the new BT mesh templates requires the use of firmware 8.4.0 or above. As 

a benefit, new device templates can be created without requiring firmware update. This 

allows creation of tailored templates for specific use cases in various projects. 

Also new templates exist for LOYBT-MSx that support configuration of LOYTEC beacons 

and the DALI gateway feature by simple assignment of DALI control gear to lamp actuator 

objects on the Web UI. 

Discovery of Devices via loytec.local 

Unconfigured LOYTEC devices starting with firmware 8.4.0 can now be easily found 

without knowing the IP address by simply calling the Web page ‘loytec.local’. The search is 

implemented as an mDNS discovery on the local network. A device finder page is displayed 

that provides links to all devices found. 

Configuration of an Internet Failover Interface 

LOYTEC devices can support multiple paths to reach the Internet. For example, Ethernet and 

an attached LTE-800 interface. For such scenarios, a failover interface can be selected. This 

failover interface is used as the default route to the Internet, if the primary interface lost 

Internet connection. This can be configured on the IP Host tab. 

 

Figure 2: Configuration of an Internet failover interface. 

Site-to-Site VPN 

This special VPN option has been added to make the LOYTEC device a VPN router between 

sites. While route to local subnet allows access from the VPN to a local node via TCP or 

request/response, a site-to-site VPN routes all traffic from local nodes into the VPN. That 

makes local nodes on network A directly talk to local nodes on network B, where networks 

A and B are connected via the VPN. 

To use this feature, a number of pre-conditions must be met that are not controlled by the 

LOYTEC device: 1) The OpenVPN server must allocate and push all respective and unique 

subnets that exist in the site-to-site VPN. 2) Each node on the local network must use a 
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gateway address that directs all non-local traffic to the VPN router. The VPN router delivers 

the traffic to the VPN. 

 

Figure 3: Enabling the site-to-site VPN router. 

4.2 New in L-INX/L-GATE 8.2.0 

L-LOGICAD Licence Discontinued on L-INX 

For new L-INX devices since production week 50/2023 (A64 models) the L-LOGICAD run-

time license is no longer available. PLC programs need to be migrated to run on the L-

STUDIO 61131 run-time instead. Upgrading older L-INX controllers to firmware 8.2.0 does 

not remove an already installed L-LOGICAD license and it can still be used. 

New generic trend mode “Interval+COV” 

Generic trends now offer a new trending mode: Interval+COV. This is a combination of 

periodic logging and COV trends. Data records are recorded when the COV condition is met 

and in a periodic fashion. 

New historic filter “Current Value” 

Historic filters can be configured to use an offset correction data point. In order to process 

the current value including offset correction, the “Current value” filter item was added. This 

item contains the offset-corrected value of the underlying data point. It can be used, for 

example, to trend an offset-corrected meter value after replacing a meter. 

 

Figure 4: Current value filter item for offset-corrected historic filters. 

Edit BACnet Priority Array on Web UI 

The detailed data point Web UI for BACnet objects now offers an editor for the priority array 

of the underlying BACnet object. The editor allows editing each priority slot, including a 

clear option to withdraw a slot. 
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Figure 5: BACnet priority array editor on the data point Web UI. 

4.3 New in L-INX/L-GATE 8.0.0 

This section describes the major changes and new features. For a full list of changes refer to 

the Readme file. 

New iCalendar Schedulers 

LOYTEC devices support a new scheduler object class that is based on iCalendar events. 

This scheduler class can be selected as an alternative to the generic scheduler class. It 

supports extended features such as events that span over midnight or last for several days, 

flexible recurrence patterns known from Outlook, and booking information. The Web 

interface has been extended to display an event view of the scheduler. External iCalendar 

data sources can be imported by using a calendar URL, which allows pulling in data from 

published Outlook or Google calendars. 

 

Figure 6: New iCalendar scheduler view on the Web interface. 
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The new currentEvent, upcomingEvent and upcomingTime data points can be used to display 

booking information of a meeting room, while the known timeToNext and nextEvent data 

points allow optimum start algorithms on the controller. 

Edge Trigger Mode 

Trends and alarms can be based on trigger conditions. There are two new trigger modes 

available: rising edge and falling edge. These can be used to trigger a recording, if the trigger 

data point changes from inactive to active (rising) or from active to inactive (falling). 

Folder Component Placeholder for Alarm Messages 

In addition to the full data point path, individual folder components of the path can now be 

addressed using the %{fN} placeholder, where N refers to the N-th folder part above the data 

point. For example on the data point “/User Registers/Building2/Floor3/Room101/temp” the 

placeholder %{f1} expands to “Room101” and %{f2} to “Floor3”. This way, individual 

compositions of the folder components can be assembled to form the alarm message. 

New WLAN Configuration Tabs and System Registers 

The WLAN configuration of the port configuration has been re-modelled to better match the 

client and access point (AP) use cases. The tabs are now labelled WLAN Client and WLAN 

Access Point. These tabs are restricted to settings that apply to their respective use. 

 

Figure 7: New WLAN configuration tabs 

The system registers have also been moved to sub-folders named WLAN Client and WLAN 

Access Point. Setting SSID, Key and writing the new Enable system register under either 

port allows enabling the client or AP, respectively. 

BACnet/SC 

LOYTEC devices support the BACnet/SC node function. This allows LOYTEC devices to 

register with BACnet/SC hubs and be integrated in BACnet/SC networks, thus benefitting 

from increased security including TLS encryption and authentication. On devices with a 

BACnet router, BACnet/SC can be enabled in addition to or as a replacement of BACnet/IP. 

Devices without the BACnet routing function can enable either BACnet/SC or BACnet/IP. 

The internal device certificate can be used out-of-the-box, and CA-signed operational 

certificates can be installed as needed. When BACnet/SC and BACnet/IP and/or MS/TP are 

enabled, the device acts as a router between those interfaces. It is also possible to run 

BACnet/SC on a separate network than BACnet/IP. 
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Figure 8: BACnet/SC configuration on Ethernet 

Node-RED™ 3.0 and AST for Scripts 

The scripting support on LOYTEC devices has been improved by supporting Node-RED™ 

3.0. This includes new editor UI features. The underlying node.js has been updated to 18.7. 

This allows up-to-date palettes and script packages to work on LOYTEC devices. 

The API available for node.js scripts has been extended to fully support alarm summaries, 

alarm acknowledgement, reading and writing schedules, as well as flexible access to historic 

data in trend logs. 

4.4 New in L-INX/L-GATE 7.6.0 

This section describes the major changes and new features. For a full list of changes refer to 

the Readme file. 

New Structure for System Registers 

The system registers have been re-organized under a folder structure. The old system register 

locations are available for back-ward compatibility. A new system register “Time Zone 

Name” has been added that allows configuration of the time zone offset and DST settings 

according to the timezone database. Writing a valid time zone name to that register sets the 

new timezone information, e.g., “CET” for Central European Time. 

 

Figure 9: New system register layout. 

WiFi Enterprise 

To further increase security in a WiFi network, IT departments support the 802.1X 

authentication method on WiFi also known as WiFi Enterprise. LOYTEC devices can enable 

WiFi Enterprise in the WiFi settings by selecting WPA2-ENTERPRISE key management. 

The authentication methods Protected EAP (PEAP), Tunneled TLS (TTLS) and EAP-TLS 

(using certificates) are supported. 
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Figure 10: Configure WiFi Enterprise 

Historic Filters 

A new filter item type has been added to historic filters: The Offset Correction item. This 

item allows correcting the underlying meter value by a given offset. That offset will be added 

to the measured value before the value is processed by other historic filters. After replacing 

a meter, the offset correction can be used to maintain continuous consumption. 

In addition, historic filter items can now be written to on the Web interface to set historic 

values. For example, it is now possible to set the value of Jan 1 or any other historic value. 

On the details page, all historic filter values can be exported to a CSV file. That file can be 

imported on other historic filter data points allowing the simple transfer of historic values. 

Node-RED™ 2.0 

The scripting support on LOYTEC devices has been improved by supporting Node-RED™ 

2.0. This includes new editor UI features. A new safe mode allows debugging problems in 

third-party packages. 

BTL Testplan 16 Certified 

The BACnet certification of all BACnet models has been updated to comply with protocol 

revision 16. All new device models are now BTL certified. New BACnet features in that 

release include  

• Support Fault_Type and Fault_Parameters in the Event Enrollment object,  

• Fault_High_Limit and Fault_Low_Limit properties, 

• Support extended “jumbo” MS/TP frames. 

4.5 New in L-INX/L-GATE 7.4.0 

This section describes the major changes and new features. For a full list of changes refer to 

the Readme file. 

New Menu Structure on Web UI 

The menu structure on the Web UI has been redesigned to be more intuitive and group 

frequent actions together. New top-level menus help keeping the menus organized into 

typical tasks, such as statistics, data viewing, commissioning, configuration, programming, 

security, and maintenance. 
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User Management on the Device 

LOYTEC devices now provide a simple user management to create users and passwords on 

the go. Users can be assigned roles, such as ‘admin’, ‘operator’ or ‘lweb’ roles. Users having 

the ‘lweb’ role are limited to using LWEB-802/803 visualization projects only and have no 

other device operation capabilities. 

The Web UI on the device allows creating, deleting and modifying users and assigning roles. 

As an example, an additional admin user can be created who is allowed to configure the 

device without knowing the master admin password. This user account can easily be disabled 

again. 

 

Figure 11: User management on the device. 

Support for LRS232-802 

The new LRS232-802 interface supports two RS-232 ports and is connected to the device’s 

USB port. LOYTEC devices that support the LRS232-802 can be configured to run Modbus 

ASCII on it or a custom RS-232 serial protocol implemented by a script module. The protocol 

settings can be found on port tabs under the USB port. 

 

Figure 12: Configure Modbus ASCII on LRS232-802. 

Late Linkage of L-IOB Native BACnet Objects 

A new feature now allows linking existing BACnet objects as L-IOB native BACnet objects 

for a given L-IOB I/O as an alternative to the automatic creation of native BACnet objects. 

This feature is beneficial when using library components with a collection of BACnet objects, 

that need to be linked to actual I/O configurations when instantiating the library components. 

This can be easily done on the L-IOB tab by choosing a BACnet object to serve as the native 

object for an I/O. 
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Figure 13: Link an existing BACnet object as a native BACnet object for an I/O. 

BACnet Features for AMEV AS-B Profile and Protocol Rev 1.15 

The BACnet implementation now supports additional features to comply with the AMEV 

AS-B profile. This includes: 

• Additional properties for the Loop object, 

• new properties for intrinsic reporting, including event and reliability inhibition, alarm 

message texts config, time delay normal, 

• External Notification-B (AE-N-E-B) in the Event_Enrollment object, 

• Minimum_On/Off_Time properties for commandable binary objects, 

• Min/Max_Pres_Value properties for Analog Value objects, 

• Current_Command_Priority for all commandable objects. 

Alarming 

Both BACnet and generic alarms now support an option to define a different delay for the to-

normal transition. Simply select the Time delay normal option and set a delay in the alarm 

condition dialog. On BACnet, intrinsic reporting and algorithmic reporting facilitate the 

property Time_Delay_Normal to carry this value. Also, the layout of the alarm dialog has 

been reorganized to better group the settings by the different alarm transitions. 

 

Figure 14: Option to define a different to-normal delay. 

New L-IOB Features 

Data points for L-IOB terminal name and description have been added. These allow 

modification via the data point interface. The I/O description can now also be changed on the 

L-IOB Web page. 

Operating mode "manual disable". This new L-IOB operating mode can be selected to 

manually disable a terminal. The setting persists an L-STUDIO deploy and cannot be 

changed over the network until the terminal is manually enabled again. 

Spike suppression on pulse counter inputs allows filtering short signal spikes. This feature 

can be used to de-bounce a contact connected to a pulse counter input. 

Network Port Authentication 

To further increase security in a network installation, IT departments support the 802.1X port 

authentication method. This standard requires a device to authenticate its port on the network 

switch, before traffic into the network is allowed. 



L-INX/L-GATE User Manual 36 LOYTEC  

Version 8.4  LOYTEC electronics GmbH 

LOYTEC devices can enable 802.1X port authentication in the port mode settings. The 

authentication methods Protected EAP (PEAP), Tunneled TLS (TTLS) and EAP-TLS (using 

certificates) are supported. 

 

Figure 15: Configure 802.1X port authentication 

4.6 New in L-INX/L-GATE 7.2.0 

This section describes the major changes and new features. For a full list of changes refer to 

the Readme file. 

Support for LTE 

LOYTEC devices now support the LTE-800 mobile interface. This interface is connected via 

the USB port and offers LTE/UMTS/GSM mobile network access. A SIM card from your 

provider needs to be inserted and the LOYTEC device is ready on the mobile network. A 

Mobile tab has been added to the port configuration interface for configuring the LTE-800. 

Simply enable Mobile Network, enter your APN data and select which protocols shall be run 

on LTE. 

New system registers offer mobile communication statistics such as Bytes transferred or SMS 

sent. The VPN client is also ready to be used on the LTE mobile network. 

 

Figure 16: LTE-800 mobile configuration 
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Internet Connection Sharing 

Combined with an LTE-800 mobile interface a LOYTEC device can act as a NAT router to 

share the mobile Internet connection with other devices on the LAN. For doing so, the 

Internet connection sharing feature can be enabled on the IP Host tab, where the default 

router interface is selected. Other devices on the LAN need to specify the IP address of the 

LOYTEC device offering connection sharing as their default gateway. This way, local 

devices can use NTP, VPN client or other Internet services. 

 

Figure 17: Internet connection sharing 

Dynamic DNS 

LOYTEC devices can now make use of a dynamic DNS service to register a public DNS 

name. This makes the device reachable over a public IP address that can change over time, 

for instance an LTE-800 mobile interface using a public IP address assigned by the mobile 

carrier. A number of dynamic DNS providers are preconfigured and can be selected on the 

IP Host tab of the port configuration as shown in Figure 18.  

 

Figure 18: Dynamic DNS Settings 

Secure Building Automation Protocols using VPN 

This firmware version enhances flexibility and control over which building automation 

protocols are directly available on the VPN. A separate VPN tab has been added to the port 

configuration that allows configuring IP-based control protocols to be running directly on the 

VPN client. This effectively secures otherwise unsecured automation protocols such as 

BACnet/IP, Modbus TCP, KNXnet/IP or CEA-852. When running on the VPN interface, the 

protocols are assigned the VPN’s IP address and as a protocol node, the LOYTEC device is 

also reachable over multi-NAT access networks, such as LTE. 

For example, simply set up the CEA-852 configuration server on the VPN interface and add 

all other CEA-852 clients on the same VPN. The same can be done for BACnet/IP. Each 

node establishes a secure channel to the OpenVPN server hub, which routes the traffic 

between the communicating peer nodes. No unencrypted traffic will ever be transmitted. 
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Figure 19: VPN tab on the port configuration interface. 

SMS Delivery 

The new SMS template message type can be used to configure SMS transmission just like E-

Mail templates for E-Mail transmission. SMS can be triggered and contain arbitrary variable 

text and placeholders. One application is SMS alarm delivery. 

 

Figure 20: SMS template configuration. 

SMS can be sent using a locally attached LTE-800 mobile interface or over the network using 

another LOYTEC device acting as an SMS proxy for its LTE-800 mobile interface. SMS 

proxy mode can be configured in the new SMS configuration menu on the Web UI. As a 

result, only one LTE-800 is required to offer SMS service for an entire local network. 

Node-RED™ Integration 

LOYTEC devices that support the scripting feature now also natively integrate the 

Node-RED™ run-time. The Web interface provides a configuration menu to open the 

Node-RED™ editor UI. As a default, the run-time is not executing and needs to be enabled. 

Once enabled, the run-time automatically starts the configured flows. An example is shown 

in Figure 21. 
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Figure 21: Node-RED™ editor UI on the device. 

The user can access data points on the device using the pre-installed ‘readDP’ and ‘writeDP’ 

palette items. Custom palette items can also be installed, like the ‘worldmap’. The editor UI 

is also accessible on a stand-alone Web browser page under the ‘/nodered’ device URL. 

Parameter and Default Values 

A new Parameter Value property has been introduced in the data point configuration that 

tracks the current parameter value on the device. This is in addition to the Default Value 

property. When uploading parameter values from the device into the configuration, the 

parameter value property is updated where selected so in the parameter merge dialog. The 

default value property remains unaffected by a parameter upload. This way it is possible to 

track current parameter values while still keeping their original default values. When desired, 

parameter values can be reset to their default values. 

 

Figure 22: The new Parameter Value property. 

New universal IN/OUT Analog/Digital L-IOB Terminal Type 

With the introduction of the LIOB-110/LIOB-590 models, a new L-IOB I/O terminal 

hardware type has been introduced: a universally configurable IN/OUT Analog/Digital 

terminal. The signal type of this terminal determines whether it is an input (measure 

resistance, current, voltage) or an output (drive 0-10V voltage output). Within its signal type 

class, the known signal interpretations can be configured (e.g. PT1000, linear, translation 

table). 

IPv6 

LOYTEC devices now support IPv6 using stateless address autoconfiguration (SLAAC) or 

having a configured, fixed IPv6 address. The IPv6 feature is available on all Ethernet and 

WLAN ports. With SLAAC no further configuration (except the required IPv6 router 
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equipment) is required. The static IPv6 address can be configured on the TCP/IP settings on 

the port configuration.  

Protocols that support IPv6 are the Web interface, SSH, HTTPS, NTP and BACnet/IPv6. 

Additional IPv6 statistics have been added to the IP statistics pages for troubleshooting. 

BACnet Dynamic Object Creation and Event Enrollment 

New BACnet protocol features have been added to LOYTEC devices. First, dynamic object 

creation is now supported for Trend_Log, Scheduler, Calendar, Notification_Class objects. 

This means that a BACnet OWS can dynamically create and delete those objects during run-

time. No reserved BACnet objects are required in the data point configuration. 

Second, algorithmic reporting has been implemented in the Event_Enrollment object. This 

object can be created and configured by a BACnet OWS to dynamically add and remove 

alarm conditions on any BACnet object in the device. 

In combination with IPv6 support, the BACnet protocol can be configured to run on the 

BACnet/IPv6 data link. Simply choose IPv6 in the BACnet/IP protocol configuration. 

4.7 New in L-INX/L-GATE 7.0.0 

This section describes the major changes and new features. For a full list of changes refer to 

the Readme file. 

Support two LMPBUS-804 

Up to two LMPBUS-804 interfaces can now be connected to the built-in USB ports of the 

LOYTEC device. This increases the maximum number for supported MP-Bus channels from 

4 to 8. Note, that no external USB hubs are supported. The LMPBUS-804 interfaces need to 

be directly attached to the two built-in USB ports. 

Alarming 

The data point alarming brings two new features for alarm messages: First, the new 

placeholders %{bacName}, %{bacDescr} have been added. These expand to the native 

BACnet server object name and description. Since these may be updated by an OWS at run-

time, alarm messages will now reflect those updates when using the new placeholders. 

Another change to alarmed data points are new property relation data points for alarm 

message texts: msgNormal, msgOffnormal, msgHigh, msgLow, and msgFault. The content 

of these property data point overwrite the pre-configured alarm messages and can be changed 

at run-time. This allows easy configuration of alarm messages by linking to common string 

data points that are parameters. For example, all temperature alarms may lnk their msgHigh 

property relation to the string parameter msgTempHigh configured to a local text such as 

“Temperature %{name} exceeds %{hi}”. 

VPN 

LOYTEC devices support joining a virtual private network (VPN). This feature is based on 

the widely-used and open-protocol OpenVPN technology. An OpenVPN configuration file 

(.ovpn) can be installed on the Web interface and makes the LOYTEC device a VPN client 

and dial into the OpenVPN server defined by that file. Any standard OpenVPN configuration 

file can be used, which is auto-login, i.e. does not require entering a password when 

connecting. After having registered, the LOYTEC device can be reached via its VPN address. 
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Figure 23: VPN client configuration on the Web interface 

Setting up a VPN client on the LOYTEC device may solve NAT router issues, because no 

port forwarding rules need to be configured. The device dials out to the OpenVPN server 

running on a public IP and establishes the VPN channel. This VPN channel provides a secure 

connection for building automation protocols, such as BACnet/IP, Modbus TCP or CEA-

852. Being part of a VPN the LOYTEC device is also reachable over multi-NAT access 

networks, such as LTE. 

An alternative method is to enable simple server mode on the LOYTEC device. In this mode, 

the device provides an OpenVPN server and allows downloading a client configuration file 

from the Web interface. This file can be installed on any OpenVPN client and allows that 

client connect to the LOYTEC device over the secure VPN channel. Only one client may 

connect at a time. 

Data Point Web UI 

The LOYTEC device is now tracking information on the source of a written value for each 

data point. This information is shown on the data point details Web UI next to the 

modification timestamp and can be used for troubleshooting, for example, whether a value 

was modified over the Web UI or is written by a local connection. 

 

Figure 24: Write source info on the data point Web interface 

Make protocol logs more verbose 

LOYTEC devices have been improved to decode protocol logs of its supported technologies 

to be displayed in a more verbose manner. This makes it easier for Modbus, M-Bus, MP-

Bus, SMI, DALI, EnOcean to analyze communication problems with other third-party 

devices. Simply click the Protocol Analyzer link on the statistics Web page of the respective 

protocol. 

EnOcean over L-STAT 

L-STAT devices with EnOcean capability can now be used by LOYTEC devices as remote 

EnOcean antennas like a LENO-800 interface. This EnOcean over Modbus feature expands 

the air coverage of EnOcean in a multi-room setup. An EnOcean repeater setup that is 

cumbersome and difficult to troubleshoot is no longer needed. Simply add EnOcean L-

STATs to extend the wireless reach of the LOYTEC device. 
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BACnet for Japan 

This software release includes some minor changes to improve BACnet interoperability in 

Japan. First, a new client mapping mode was added: COV unsolicited + poll. In this mode 

the client map not only accepts updates via unsolicited broadcast messages but also actively 

polls the remote devices. Second, any kind of UnconfirmedEventNotification broadcast 

(event or alarm) can be used to receive value updates. Third, also status flags of client 

mappings are updated by event/COV notifications that include status flags. 

Support Custom Serial Port in JavaScript 

A new API has been added that allows using the serial port on a LOYTEC device in 

JavaScript. This feature can be used to implement custom serial protocols. The port Web 

interface offers a choice to select such a custom serial implementation based on meta data 

provided by the JavaScript module. An example for such custom protocol support is DMX, 

which is distributed as an add-on script resource. 

 

Figure 25: New Web interface to select custom serial protocols. 

Other scripting features added to this release are defining debug filter keywords on the Web 

interface, enabling and disabling scripts, and a new system API to allow firewall ports on the 

LOYTEC device. 

4.8 New in L-INX/L-GATE 6.4.0 

This section describes the major changes and new features. For a full list of changes refer to 

the Readme file. 

Localized Web Interface 

The entire Web interface of the device has been localized to German, French, and Chinese 

language. Simply change the language on the LCD display or directly on the Web interface 

via the new flag symbol on the upper right corner. Changing language is instant and does not 

require a reboot. 

 

Figure 26: Language selection on the Web interface 
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Safe Reboot and Auto-Login 

Changing IP settings and rebooting could end in a device unreachable, if something was 

different than expected. The new safe reboot feature helps out by reverting the changes made, 

if not logged in in on the Web interface within 5 minutes after the reboot. Locking oneself 

out by entering a mistaken IP address is no longer possible. 

 

Figure 27: Safe reboot screen suggesting new IP address. 

Another new feature that helps getting logged in again is the session auto-login. After a 

device has rebooted the Web interface restores the session and automatically logs in again. 

Even when changing a static IP address the device tries to connect to the new IP or suggests 

links for opening the device info page under the new IP address. 

Backup before Upgrade 

The firmware upgrade feature has been made safer by creating a backup before executing the 

upgrade. This feature has been added to firmware and Configurator upgrade paths. It is, 

however, optional and can be turned off by deselecting the check box. 

 

Figure 28: Backup before Upgrade on the Web interface. 

Multiple M-Bus Ports 

LOYTEC devices with multiple EXT ports now support operating an LMBUS-20/80 

interface on each port in parallel. This way the total number of M-Bus devices managed by 

the LOYTEC device can be increased by using several LMBUS-20/80 interfaces. The 

commission Web interface supports EXT port assignment and moving M-Bus devices from 

one EXT port to another. 

Binary Interpretation of Analog Inputs 

A simple way to turn an analog universal input (UI) into a digital data point has been added. 

On the UI select the option Digital Input and enter an on/off value hysteresis. A binary data 

point will be created instead of the analog one. 

Support Custom Protocols and IoT by Scripting 

New models of programmable L-INX and L-GATE devices now include a JavaSript-based 

scripting engine. This engine allows users to implement their own protocol support for the 

IoT world using RESTful APIs, JSON or Web services. The LOYTEC data point server 

allows integrating data points into the scripting language using the dpal-js API. The script 

modules can be embedded into and deployed along with the data point configuration. 
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Figure 29: Web interface for scripting engine 

The Web interface of the device offers an overview of installed script modules and allows 

starting scripts in debug mode. Use the Google Chrome inspector to debug JavaScript on the 

device. For more information read the new Scripting Chapter in the LINX Configurator User 

Manual [2]. 

4.9 New in L-INX/L-GATE 6.3.0 

This section describes the major changes and new features. For a full list of changes refer to 

the Readme file. 

KNX 

The KNX implementation has been reworked. The new version lowers average CPU load 

and increases performance. 

4.10 New in L-INX/L-GATE 6.2.0 

This section describes the major changes and new features. For a full list of changes refer to 

the Readme file. 

New Models 

The L-INX automation server family has been extended by two new programmable all-

rounder models. The new LINX-215 combines the functionality of all LINX-11x, 21x. It 

provides both router and RNI functionality, which can be configured as needed. The LINX-

153 as the larger sibling combines the functionality of the bigger L-INX models LINX-12x, 

15x, 22x and also provides a configurable router/RNI. The new LINX-154 model has been 

designed to accommodate a maximum number of Modbus RTU and/or BACnet MS/TP 

devices on its four RS-485 ports. 

L-STUDIO 3.0 with 61131 Run-Time 

New L-INX and L-IOB controller models are now embedded into the L-STUDIO workflow 

using a 61131 program run-time environment. This new environment combines both 

advantages, the well-known 61131 programming workflow and the powerful mechanisms of 

L-STUDIO for mass-engineering LOYTEC controllers. Support for the previously used 

logiCAD run-time and programming tool is also continued for existing products. 
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LMPBUS-804 

The LMPBUS-804 interface is supported. This is a four-channel MP-Bus interface connected 

to the USB port of the LOYTEC device. The PPX addressing mode is now also supported 

for MP-Bus as well as an MP-Bus scan engine. For more information on MP-Bus read the 

respective Chapters in the Device User Manual [1] and the LINX Configurator User Manual 

[2]. 

LCD Interface 

The user interface on the LCD display has been extended by a firmware upgrade menu. This 

menu allows installing a new firmware image from an attached USB memory stick. This is 

beneficial for WLAN-only devices. When plugging in a USB memory stick, a menu pops up 

(Figure 30) on the LCD interface that shows selected quick options, including firmware 

upgrade and backup. 

 

Figure 30: LCD pop-up menu for USB storage 

BACnet Features 

A new BACnet client mapping type has been added: The COV unsolicited type. This new 

read mapping type, a client mapping will accept broadcast COV updates without 

subscription. 

A new type of BACnet favorites has been added, which offer BACnet-related options such 

as adding BACnet properties. When linking a BACnet favorite to a BACnet server object, 

the respective BACnet property data points are added and linked to the link target. 

L-IOB Firmware Upgrade and V2 Models 

The L-IOB firmware upgrade has been enhanced by a parallel upgrade mode. This mode is 

back-ward compatible to existing L-IOB devices and allows parallel upgrade over the 

network. This means a number of devices receive the firmware upgrade at the same time 

which greatly improves upgrade time over LIOB-FT. This also applies to the new V2 L-IOB 

models. The Configurator firmware upgrade dialog has also been extended to allow the 

assignment of a universal L-IOB firmware ZIP archive to all L-IOB models. 

Web UI 

The data point details page on the Web UI provides write usage information. This information 

can now be used to determine by which objects a certain data point is being written to. The 

Web UI design has also been reworked according to the latest security standards, now 

suggesting usage of strong passwords. 

4.11 New in L-INX/L-GATE 6.1.0 

This section describes the major changes and new features. For a full list of changes refer to 

the Readme file. 

LSMI-804 

The LSMI-804 interface is supported. This is a four-channel SMI interface connected to the 

USB port of the LOYTEC device. It also contains four relays for SMI channel power-on 
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functionality. This saves energy while the SMI bus is idle. For more information on SMI read 

the respective Chapters in the Device User Manual [1] and the LINX Configurator User 

Manual [2]. 

Selective Backup and Restore 

The backup and restore interface on the Web interface has been extended by content options. 

It is now possible to decide whether a created backup shall contains passwords, IP settings 

or historical data (trend logs, alarm logs). Also when restoring a backup archive it can be 

selected whether password and IP settings shall be accepted from the backup or not. This 

makes it easier to replicate devices without scarifying the IP configuration and password 

settings. An example is shown in Figure 31. 

 

Figure 31: Backup and restore options on the Web UI. 

L-STAT Configuration Backup 

The Modbus commission Web UI has been extended to better support L-STAT devices. Now 

it is possible to upload one or more L-STAT backup files and save them on disk. Those L-

STAT backup files can also be restored to L-STAT devices. The regular device backup now 

includes all L-STAT device backups as well. 

Advanced WLAN Mesh Configuration 

The WLAN Mesh configuration has been enhanced by a graphical floorplan editor as well as 

an online monitor of inter-link communication quality. This tool allows not only easier setup 

of a Mesh network but also simple troubleshooting by identifying radio bottleneck between 

Mesh points (see Figure 32). 
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Figure 32: Mesh floorplan and online link quality monitor 

Flexible Column Layout in Configurator 

The Configurator now supports a flexible column layout in the data point list. It is possible 

to modify the column arrangement and add/remove columns as needed. This provides for 

better overview in situations where the default column layout misses important information. 

The new Configure Columns dialog makes this possible. 

Incremental Data Point Scan 

The data point scanning engine of the Configurator has been extended to mark data points 

already used on the device and data points found in new scans. The last two columns Used 

on Device and Last Scan of Figure 33 show an example and can be used to sort the list. This 

way the data point configuration can be easily adapted to incremental changes of the scanned 

devices. 

 

Figure 33: Example of an incremental data point scan 

LCD Interface 

The user interface on the LCD display has been localized for the Chinese simplified and 

traditional language sets. The language can be selected from the main page and is switched 

immediately without a device reboot. 
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Another feature on the LCD display is the option to rotate the display 180 degrees. This is a 

useful setting, if the device is mounted upside down. 

EnOcean VLD Profile Support 

EnOcean devices that require variable-length data (VLD) profiles are now fully supported. 

The respective device templates are provided by LOYTEC. In addition to new profiles, the 

teach-in process on the Web interface has been improved by dialog wizards that guide 

through bi-directional teach-in and assignment of transmission IDs. 

4.12 New in L-INX/L-GATE 6.0.0 

This section describes the major changes and new features. For a full list of changes refer to 

the Readme file. 

New User Manual Structure 

The L-INX/L-GATE User Manual has been split up into three parts: The L-INX/L-GATE 

User Manual, which now covers the specific functions of the L-INX and L-GATE device 

models. The LINX Configurator User Manual is a common description for using the 

Configurator software for the L-INX, L-GATE, L-ROC, L-IOB, and L-DALI product line. 

And the LOYTEC Device User Manual covers hardware, Web interface, LCD display and 

operating interfaces topics common to all LOYTEC devices. 

New Models and Combined Firmware 

The new LROC-400 room controller models are now supported by the device firmware and 

in the LINX Configurator. The different device firmware images for LROC-10x, LIOB-AIR, 

and LROC-400 have been integrated in one image for all L-ROC, L-INX, LIOB-AIR and L-

GATE models. 

SMI 

A new protocol is now supported: SMI for controlling sunblinds over the Standardized Motor 

Interface. All LOYTEC devices with an EXT port can now be extended by the L-SMI 

interface and connect to an SMI bus. The LINX Configurator provides SMI device templates, 

which can be commissioned on the device Web interface. The Web interface supports manual 

address assignment, scanning for SMI devices and calibration. For more information on SMI 

read the respective Chapters in the Device User Manual [1] and the LINX Configurator User 

Manual [2]. 

Flexible CSV Import/Export 

The entire CSV import/export engine of the LINX Configurator has been revisited. 

Previously special export options with fixed columns for CEA-709, Modbus, etc. have been 

replaced by a general CSV engine that is able to configure columns for any set of data point 

properties. Default property sets have been added, which can be modified by the user and 

saved for later use. The new CSV import/export allows modifying existing data point 

properties by batch edit in Excel or creating new data points. The property sets can be viewed 

and modifed in a comfortable export editor (see Figure 34). The new engine also integrates 

CSV data point templates. Learn more about this flexible import/export mechanism in the 

LINX Configurator User Manual [2]. 
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Figure 34: CSV export dialog with configurable columns. 

Override Function for Data Points 

The data point model in LOYTEC devices has been extended with a manual override 

function. On the Web interface and on the LCD display data point values can be overridden 

to manual values. If an override value is set, the running control logic no longer affects the 

data point value, neither does network communication. The override value is in effect until 

it is removed again by the user. 

 

Figure 35: Overriding a data point on the Web interface. 

WLAN Mesh Configuration 

The Mesh Point mode has been extended by a whitelist function. This allows configuration 

of a Mesh network with up to 32 nodes. The whitelist contains all mesh point IDs that may 

contact each other. In order to make configuration of the mesh network easier, the Quick 

Wireless Setup has been added, which allows a first mesh setup in only a few steps. For 

optimizing the whitelist the Web interface offers a graphical editor, which makes changes 

quick and simple. On device models with an LCD display the wireless setup can also be 

completed using the jog dial. For more information on how to set up a Mesh network please 

refer to the respective Sections of the LOYTEC Device User Manual [1]. 

Alarm Messages 

The length of alarm messages has been extended to 250. This increased length comes in 

combination with a new %{path} variable placeholder that can identify the data point path 

in alarm messages. This is beneficial for mass-engineering alarm conditions on data points 
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that have the same name but are located in different path locations. Alarm logs have also 

been updated to support the new maximum legnth. BACnet now supports the Event Message 

Texts property of an alarmed object, which allows retrieving the messages also after a reboot 

of an alarm client. And analog alarm conditions have been extended to specify a high limit 

and a low limit alarm message. 

Trend Logs 

The generic trend logs have been extended to support recording string values. These trends 

can be operated as polled, COV or triggered. These trend logs can be beneficial to record 

arbitrary messages The string recording is currently limited to generic trend logs only. 

New E-Mail Placeholders 

E-Mail configuration has become even more flexible by adding new variable placeholders. 

The variable placeholders can be augmented by name, description and path specifiers that 

expand to the respective information in the e-mail. A new date format specifier allows for 

readable timestamps and the %{last_timestamp} variable expands to the time the last e-mail 

was transmitted. 

BTL Testplan 12 Certified 

The BACnet certification of all BACnet models has been updated to comply with protocol 

revision 12. All new device models are now BTL certified. 

4.13 New in L-INX/L-GATE 5.3.0 

This section describes the major changes and new features. For a full list of changes refer to 

the Readme file. 

New L-INX and L-GATE Models 

The new L-INX and L-GATE models in the small enclosure are now supported. Equipped 

with dual Ethernet, a built-in firewall and LCD display, these new models serve as a plug-in 

replacement for the older devices. Existing data point configurations and device backups can 

be used without modification. Only logiCAD programs need to be re-compiled for the new 

hardware resource. In addition, the new models also support L-IOB connect, wireless 

technologies and KNX. 

Extended Support for U.S. Units 

An extended support for U.S. units has been built into LOYTEC devices. A device can now 

be configured to run either in the SI or the U.S. unit system by defining SI and U.S. units per 

data point as shown in Figure 36. When configured for U.S. units, all data points and L-IOB 

I/Os process values in the respective U.S. units. This includes the Web UI, the OPC server, 

the parameter file, global connections, and logiCAD programs. Also the Configurator 

displays values in U.S. units and conversions are done automatically. A device can even be 

switched from one unit system to the other. In this case all persistent parameters are reset to 

their default values in the chosen unit system. A system register shows the currently running 

unit system. This makes it easy to entirely engineer a device in U.S. units or build devices 

that can be configured for either European or U.S. markets and meet local requirements at 

the same time. For more information on units please refer to the LINX Configurator User 

Manual [2]. 
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Figure 36: Configuration of SI and U.S. units on a data point 

OPC Client 

L-INX and L-GATE devices are extended by their own OPC client technology. Using the 

OPC client you are able to integrate other LOYTEC devices simply by importing the data 

point configuration of their OPC servers. This way an L-DALI device can be added to a 

L-INX configuration in a few steps. The OPC client can also take advantage of the 

commission later feature by using the Web UI in order to assign OPC server URLs at the 

time of device commissioning. Even the base path to imported OPC tags can be replaced. 

This way sub-configurations can be imported to save OPC client tags and be re-assigned 

later. Learn more about the OPC client function in the LINX Configurator User Manual [2]. 

Forward Delay in Connections 

For applications that require staggered start/stop and randomization, the device implements 

a configurable forward delay in local and global connections. All receive data point items 

can be configured with a delay. A received value is written to the data point after the delay 

expires. The delay can be a fixed time or a time interval, in which the actual delay is 

randomized. With a resolution of 0.1 seconds the total delay can be up to 100 minutes. Learn 

more about forward delay in the LINX Configurator User Manual [2]. 

Auto-Generate and Connect 

The auto-connect feature has been extended: 

• Support %{folder_descr} as a placeholder in auto-generate templates. This 

evaluates the description property of the parent folder. 

• Generate into existing connections. Epecially when auto-generating the same source 

data points to different technologies, the same connections are used. This makes it 

easier to manage auto-generated local connections. 

Enhanced Structure Support on the Web UI 

The display of data point structures has been improved on the Web UI. The data point listing 

shows a textual short version of the structured value instead of a hexadecimal Byte buffer. 

Also CEA-709 structures of NVs without sub-data points are displayed and can be edited.  

Project Documentation 

A new feature on the device is a Web UI for creating and viewing project documentation on 

the device. The documentation editor requires admin rights and allows storing files on the 

device or creating documentation links as URLs. Both items can be viewed by guest users. 

Examples include storing cabling plans as PDF or adding links to a Web site containing 

manuals, plans or other useful project documentation. Consult the LOYTEC Device User 

Manual [1] to learn more about project documentation on the device. 

LWEB-802 Application on Device 

The L-INX and L-GATE device now come with a pre-installed version of the LWEB-802 

application. This enables out-of-the-box L-WEB applications on sites without Internet 

access. An enhanced Web UI also allows installing a specific version of the LWEB-802 

application, which overrides the pre-installed one. As a default, the Internet version is still 
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available. To learn more on how to configure the L-WEB application refer to the LOYTEC 

Device User Manual [1]. 

BACnet 

All previously extended BACnet features and new features have been BTL-certified in the 

5.X firmware series. New features include: 

• BACnet object names can be made writeable. With this new option the user can create 

data point configurations with generic object names and assign location-specific names 

later in his OWS. 

• BACnet simple value objects are now supported. The user can create Large Analog 

Value, Signed Integer Value, Unsigned Integer Value, Character String Value and Octet 

String Value objects as needed. Also auto-connect supports these new object types. 

• For Trend Log objects, the properties Notify_Type, Event_Enable, Notification_Class 

can be pre-configured in the data point configuration. 

User-defined Serial Protocols in logiCAD 

A new logiCAD service block has been introduced, which allows implementation of generic 

serial protocols. The ‘SerialComm’ service block can receive and transmit strings from and 

to a serial port using start frame and end frame delimiting characters. A logical bus number 

is assigned to the service block, which can be selected as a custom serial protocol on the port 

configuration Web UI as shown in Figure 37. Please read Section 8.6.10 to learn more about 

using the ‘SerialComm’ block. 

 

Figure 37: Selecting a custom logiCAD serial protocol. 

Data Point Creation from CSV Lists 

The Configurator implements a new data point template CSV import feature, which can be 

used by external tools to generate a list of data points. Each line in this CSV references a data 

point template file that describes all properties of the data point. The CSV supplies name, 

description and path of the data point to be created. Additionally, data points can be 

automatically scheduled and trended. Learn more about data point templates in the LINX 

Configurator User Manual [2]. 

KNX Protocol Analyzer 

Devices that support the KNX protocol now have a built-in protocol analyzer. It can be 

accessed through the KNX statistics Web interface and allows starting, stopping and storing 

protocol logs on any of the KNX interfaces. Protocol logs can be loaded from the device and 

stored on the PC either in CSV or in XML format. The XML format can be opened in the 

ETS protocol viewer. Learn more about the KNX protocol analyzer in the KNX Chapter of 

the LOYTEC Device User Manual [1]. 



L-INX/L-GATE User Manual 53 LOYTEC  

Version 8.4  LOYTEC electronics GmbH 

ekey Fingerprint Readers 

LOYTEC devices can now be used to build applications with biometric access control 

(fingerprints). The ekey fingerprint reader devices can be attached to the RS-485 port. Users 

and fingers can be enrolled and grant or deny access when swiping the finger over a reader. 

User groups can be implemented and distributed over reader devices. Learn more about ekey 

fingerprint reader support in the ekey Chapter of the LOYTEC Device User Manual [1]. 

4.14 New in L-INX/L-GATE 5.1.0 

This section describes the major changes and new features. For a full list of changes refer to 

the Readme file. 

Dual-Ethernet with Separate Networks 

L-INX and L-GATE models with two Ethernet interfaces can now be configured to work 

with separate and isolated IP networks. For example, one Ethernet interface can be accessed 

over HTTPS from a WAN connected to Ethernet 2 while the building network services are 

running locally on the LAN connected to Ethernet 1. For configuration the device provides 

separate Ethernet tabs in the port configuration, which allow selecting the offered services 

on each interface. The example in Figure 38 shows a WAN interface with HTTPS and OPC 

UA only, while BACnet/IP or CEA-709 over IP are still bound to Ethernet 1 (LAN). Another 

use case for this feature is operating a gateway between otherwise entirely isolated building 

networks, e.g. BACnet/IP on Ethernet 1 and KNXnet/IP on Ethernet 2. 

 

Figure 38: New Ethernet 2 (WAN) tab 

WLAN Interface 

In combination with the external LWLAN-800 interface, the device provides new interface 

tabs for wireless IP networks. Similar to the second Ethernet interface, one can choose which 

protocols are available on the wireless network. The wireless interface can be configured as 

a WLAN client, access point or mesh node. Using the latter, a wireless mesh network of 

LOYTEC devices can be built. Please refer to the LOYTEC Device User Manual [1] to learn 

more about the WLAN interface. 

EnOcean 

The EnOcean technology is now supported by the L-INX and L-GATE devices. Together 

with the external LENO-800 interface, EnOcean sensors and actuators can be easily 

integrated. LENO-800 interfaces are available for European, U.S. and Japanese frequency 
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bands. Data point configurations for the EnOcean technology are built using EnOcean device 

templates. The actual assignment of physical devices is done later in the teach-in process 

over the Web UI. For more information on the EnOcean technology please refer to EnOcean 

Chapter of the LOYTEC Device User Manual [1]. 

SNMP 

For accessing vital operational data in standard IT equipment, L-INX and L-GATE devices 

offer an SNMP management base (MIB). All system registers and OPC-exposed data points 

are available in that MIB. The MIB file can be downloaded from the device and imported in 

the SNMP management tool. Alarms on the device can be exposed as SNMP traps. For more 

information on configuring and using SNMP with a LOYTEC device please refer to the 

LOYTEC Device User Manual [1]. 

Online Commissioning 

The Web interface of the device now provides an online commissioning tool for the 

respective networking technologies. Using this tool, data point configurations can be created 

based on placeholder devices, which are marked to be commissioned later. The necessary 

addressing information can be assigned later on the Web interface by scanning for devices 

online or be entered manually. Device replacement is also possible in the commissioning 

Web interface without the need to edit devices in the data point configuration. For more 

information on the commissioning Web UI please refer to the LOYTEC Device User Manual 

[1]. 

Favorites 

Enhancements for using favorites include engineering units, active/inactive texts, multi-state 

texts and value persistency for unlinked favorites. A new feature are structured favorites. For 

example, the structure of a SNVT_switch may now be created as a favorite. The top-level 

part of a structured favorite can be linked to a structured data point of the same type. 

Alternatively, the individual member elements of a structured favorite can be linked to other, 

individual data points. This way, one is able to create a structured favorite, that can be linked 

directly to a matching SNVT or to separate BACnet objects.. 

Web Interface 

The Web interface of the device offers a number of new features: 

• A new device info page provides a quick overview of all relevant operational parameters, 

such as CPU load, active protocols, time synchronization and many more. 

• The trend log configuration on the Web UI now also provides a preview tab, which 

shows a chart of the trend log data. The trend chart allows zoom, scrolling and hiding 

specific data curves, as shown in Figure 39. 
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Figure 39: New trend chart on the Web UI 

Scheduler 

The scheduler objects have been extended by the following new features: 

• Color support in BACnet and generic schedulers allows consistent assignment and 

display of preset colors in L-WEB, L-VIS and the Configurator scheduler UIs. 

• Event auto-prune removes passed events, if the capacity of exception events in a 

scheduler gets low. 

• The scheduler default for LONMARK and generic schedulers is extended by a “silent” 

mode. In this mode the scheduler becomes inactive as soon as the last event is withdrawn. 

This mode can be used in event-driven scheduler models. 

• Generic schedulers allow specifying an existing value preset as the schedule default. 

LONMARK and BACnet schedulers try identifying a matching preset name from the 

schedule default value. 

5000 BACnet Client Maps and Dynamic Polling 

The number of BACnet client mappings on the L-INX has been increased to 5000. This has 

become possible with the use of strict on-demand dynamic polling on the device. This means 

any data point configured for polling (client mappings, external NVs, Modbus, etc.) will start 

polling only when it is actually used, i.e. displayed on L-WEB, the data point Web interface 

or used by a trend log. This reduces the required network bandwidth. 

1000 Trended Data Points in LINX-12x/15x/22x/LGATE-95x 

The bigger L-INX and L-GATE devices now allow a total of 1000 trended data points 

distributed among the 512 trend logs. This limit can be exploited when trending two or more 

data points in a generic trend log. 
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Alarm Server Ack-All Data Point 

Alarm servers now provide a special ackAll property data point. When writing TRUE on that 

data point all currently active alarms on the alarm server are acknowledged. 

Format Strings in E-Mails 

Data point variables used in e-mail templates can now use format strings to specify their 

numeric appearance in the e-mail text. 

Output NVs with Integrated Feedback 

Output network variables (NVs) are used to send updates to remote nodes. In order to poll 

back the actual value of the remote variable, a feedback data point had to be created for the 

output NV. Now changing the direction on the NV from output to value, an integrated 

feedback function is activated without the need for an extra data point. This becomes 

especially useful in data point templates. 

Modbus and M-Bus Templates 

Modbus and M-Bus device templates offer some new features that boost productivity: 

• Templates can now contain definitions of pollgroups and other type resources used by 

Modbus data points. 

• Templates can now store a folder hierarchy. 

4.15 New in L-INX/L-GATE 5.0.0 

This section describes the major changes and new features. For a full list of changes refer to 

the Readme file. 

Generic Scheduler 

Generic schedulers – like generic trends and alarms – can now be created, that are neither 

CEA-709 nor BACnet objects. Generic schedulers appear next to the generic alarm folder 

and are ready-to-use on any device. This is beneficial for creating technology-independent 

applications. Generic schedulers can write to any technology as well as data point favorites 

and are the ideal solution, if configured via LWEB-900 only. For more information on 

creating generic schedulers refer to the LINX Configurator User Manual [2]. 

Optimum Start for Schedulers 

Up to now, optimum start was limited to using a SNVT_tod_event in a CEA-709 scheduler. 

Now all schedulers (including BACnet and generic schedulers) support timeToNext and 

nextState data points for implementing optimum start algorithms also for those technologies. 

Schedulers are extended by property relations, which offer the time to the next state in 

minutes and the next state in data points. Also, the enable, enableFb (feedback), and 

presetName information is available as property relations. 

The BACnet scheduler object also has custom properties that expose time to next state and 

next state to BACnet. If standard BACnet objects are required, the property relations can be 

linked to any matching BACnet server object as shown in Figure 40 (BV_nextState, 

AV_timeToNext). 
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Figure 40: BACnet scheduler with next state data points. 

Favorites 

Favorites have been vastly extended to be compatible with all uses that were previously only 

possible for regular data points. Favorites can now be trended, can have an alarm condition 

(reporting to a generic alarm server), and be scheduled. Historic filters can be applied to 

favorites. Favorites can also be used in e-mail templates, math objects and connections like 

any other data point. Furthermore, it is possible to link favorites to property relations and 

vice versa, e.g. link a favorite directly to a historic filter data point. 

Historic Filters 

Historic filters have been extended by a generic delta calculation between any of the defined 

filter items or the current value. This way, it is no longer necessary to create a separate math 

object to calculate the consumption of the previous month. Also, a definition for “last day of 

month” has been added to the monthly period. 

256 Trend Logs on LINX-10x/11x/20x/21x/LGATE-900 

The smaller L-INX and L-GATE devices are now extended from 100 trend logs to 256 trend 

logs at a total of 256 trended data points. This is beneficial for native BACnet trend logs, 

which allow only one data point per trend log object. The increase comes at the cost of 

available log rate, which is reduced from 121,050 to 60,525 records per hour, once more than 

100 trend log objects are created. This is, however, still sufficient for 256 energy trends at 1 

minute log interval each. 

Web Interface 

The Web interface of the device offers a number of new features: 

• Live update of values in the data point list. This allows monitoring values without 

repeated pressing of reload. Data point structures can be expanded or collapsed for better 

overview. 

• Breadcrumb navigation has been added to the data point list. This gives faster access to 

sub-folders. 

• A new firmware upgrade menu on the Web interface allows online checking for 

firmware updates and upgrading by selecting a local firmware file. All this is possible 

without starting the Configurator. 

• The trend overview page displays current trend log states and provides controls for easy 

trend data upload in CSV format. 

Data Point Polling 

The receive timeout on input and value data points has been generalized. A receive timeout 

can now be defined on all technologies for input and value data points. Writing updates to 

those data points from any source (e.g. a global connection) resets the receive timeout. 
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Background polling can be enabled in the project settings, which allows a slow polling of all 

data points even if no pollcycle or dynamic polling has been activated on those data points.. 

OPC UA Server 

The OPC server on the devices, which support security, has been extended by an OPC UA 

server. This supports the OPC UA binary protocol and exposes the same OPC tags as the 

well-known OPC XML-DA server. In addition OPC UA offers superior security features as 

well as slimmer data transfers. For more information on the OPC UA server please refer to 

the LOYTEC Device User Manual [1]. 

BACnet 

All previously extended BACnet features and new features have been BTL-certified in the 

5.X firmware series. New features include: 

• Intrinsic alarming for the Accumulator object. 

• Option to keep OWS settings in BACnet properties also after a new configuration has 

been downloaded. 

• BACnet naming rules can now freely define how data point names are constructed out 

of scanned BACnet information. 

Conversion to Value Data Points 

Firmware versions since 4.9.0 support value data points. The default behavior of the 

Configurator can be controlled in the project settings. This defines whether new value data 

points or the old “_Read/_Write” data point combinations shall be created. When using 

templates in L-WEB or L-VIS it is often an all-or-nothing approach, a mixture is not 

practical. 

For making the transition in old projects to value data points, the Configurator now offers a 

conversion tool. Multi-select old read/write data points and choose the item Convert to value 

from the data point context menu. This converts the selected data points to the new value data 

points, leaving the IDs, default values and data point usages intact. 

Application Objects 

Application objects such as math objects, e-mail templates, and alarm logs can now be 

organized in folders. Copy and paste of application objects between Configurators has been 

improved. Math objects now allow single constants and single variable assignments, such as 

“=5” or “=v1”. Input variables can be configured to trigger a new calculation or not. 

Configurator Usability 

The folder tree of the data point manager has been brought to state-of-the-art user concepts 

such as multi-select, drag-and-drop of folders, moving folders, deleting multiple folders and 

their contents. A name filter can be applied to quickly find folders in the folder tree. 

The property tab has been extended by a property name filter. This makes it easy to find the 

desired property by typing a sub-string of its name in the filter. For a detailed description on 

the data point properties refer to the LINX Configurator User Manual [2]. 

Data point link navigation has been made easy by using a Go to data point context menu 

and speed button everywhere data point references are displayed. A data point usage report 

dialog shows all references to the selected data point and allows jumping to selected objects. 

The new PLC conflicts tab shows all PLC write conflicts with other write usage of data 

points such as math objects, connection receivers, etc., while editing the project. This allows 
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finding problems prior to the configuration download. The conflicts tab also provides easy 

navigation to data points listed as problematic. For more information refer to Section 8.4.7. 

Modbus and M-Bus Templates 

Modbus and M-Bus device templates offer some new features that boost productivity: 

• Allow setting the device name when storing the template in a file. 

• Naming rules for created data points when used on device. 

• Configure naming rules for the automatic naming of Modbus devices (e.g. with or 

without device address). 

• Templates include all OPC and PLC settings. 

• Imported device templates are also stored in the device configuration. They are now also 

available after loading a configuration out of the device, not only from the disk file.  
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5 Quick-Start Guide 

This chapter shows step-by-step instructions on how to configure the L-INX for a simple 

OPC server application with a logiCAD program and using basic I/Os in L-IOB modules. 

For the L-GATE it gives an example of how to quickly map CEA-709 network variables to 

BACnet objects in the gateway. 

5.1 Hardware Installation 

Connect power (12-35 VDC or 12-24 VAC), the CEA-709 and/or MS/TP network, and the 

Ethernet cable to the ports, which are labeled respectively, as shown in Figure 41. More 

detailed instructions are shown in Chapter 6. 

Important: Do not connect terminal PWR Supply + with Earth-ground! 

 

Figure 41: Basic Hardware Installation. 

If the L-INX device is connected to a BACnet MS/TP network, the MS/TP network segment 

must be properly terminated with an LT-04 network terminator connected at each of the two 

ends of the segment media. 

5.2 Configuration of the Device 

The device can be configured via LCD display or via the Web interface. To configure the 

device, the following steps have to be performed: 

1. Setup IP configuration (see Sections 5.2.1 and 5.2.2). 

2. Setup basic BACnet configuration (see Section 5.2.3). 
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3. Setup the OPC configuration (see Section 5.3). 

Note: This setup procedure assumes the use of the IP interface.  

5.2.1 IP Configuration via the Web Interface 

LOYTEC devices are shipped with DHCP and will acquire an IP address as soon as they are 

connected to the network. To use a static IP you can use the Web interface to configure the 

client device. In a Web browser enter the IP address of the device which can be read on the 

LCD display. Note that your PC must be attached to the same subnet as the device. For 

devices with a default IP address choose the setup on the LCD display. 

To Configure a Static IP 

1. Open your Web browser and type in the IP address shown on the LCD display or type 

in ‘loytec.local’. As a first step you will be asked to enter passwords for the administrator 

and operator accounts before proceeding. Only strong passwords are accepted. 

 

Figure 42: Enter passwords for admin and operator accounts. 

2. Then click on the Config menu. Click on Port Config and change to the tab Ethernet. 

The TCP/IP settings are selected as shown in Figure 43. Enter the IP address, the IP 

netmask, and IP gateway for this device. 
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Figure 43: Enter IP address and gateway. 

3. Press Save Settings and then reset the device by selecting Reset in the highlighted text. 

This changes the IP settings of the device. 

5.2.2 IP Configuration via the LCD Display 

Device models with an LCD display can also be configured to their basic settings through 

jog dial navigation on the LCD UI. Turn the jog dial to navigate between menu items and 

press to enter a menu or go into selection mode. When in selection mode turn the jog dial to 

alter the value and press again to quit the selection. Some input fields provide acceleration. 

This means turning faster changes the value in larger increments. 

To Set the IP Address on the LCD Display 

1. On the LCD main screen set the desired language. Navigate to the language icon , 

press the button and choose the desired language. 

2. Navigate to the IP address on the main screen and press the button.   

 

  

3. There navigate to the needed input fields, press and change the value. Press again to set 

the value. Continue to the next field.  

 

 

4. Finally navigate to Save and reboot and press. 

5. Acknowledge the reboot and the device reboots with the new IP address. 
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5.2.3 BACnet Configuration 

To configure the BACnet interface, at least the Device ID and the Device Name must be 

configured (see Figure 44).  

 

Figure 44: BACnet Device Configuration. 

The device ID corresponds to the instance number of the BACnet device object. It must be a 

unique ID on the BACnet internetwork. Also the Device Name must be a unique name on 

the BACnet internetwork. 

By default the BACnet/IP data link layer is used. If the device shall be used with the BACnet 

MS/TP data link layer, please refer to the LOYTEC Device User Manual [1] for further 

information. 

On devices with an LCD display, the BACnet device ID can also be configured over the LCD 

UI. 

To Configure the BACnet Device ID over the LCD Display 

1. On the LCD main screen navigate to Device Settings »». 

2. Then navigate to the menu BACnet »». 

3. In that menu navigate to the ID input for entering the device ID. The field is split into 

two controls, one for the thousands and one for singles, to simplify entering big numbers.

   

 

  

4. After the device ID has been entered the device name is automatically assembled using 

that device ID, if no other name has been configured on the Web UI. 

5. On a BACnet router navigate to the BAC/IP Net menu item and enter the BACnet 

network ID of the BACnet/IP network. Then choose the appropriate MS/TP Net number 

for each available MS/TP port. To disable the router port, scroll down till off appears. 

6. To let the changes take effect, the device needs to be rebooted. For doing this now you 

may select the menu item Save and reboot. 

5.2.4 License Activation 

On the L-INX devices certain features must be activated by entering a license PIN code on 

the Web interface or the LCD UI. This license PIN code is entered only once and remains on 

the device for its lifetime. 
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To Activate a License on the Web UI 

1. Go to the menu Config → License. 

2. Enter the 12-digit license PIN code and click on Activate PIN. 

 

3. The list of activated features now lists the PIN code and activated license. 

4. Finally, reboot the device to start the activated feature. 

5.2.5 LWEB-900 VPN Enrollment 

The VPN Setup menu  allows configuring the LWEB-900 VPN connection. In the setup 

menu, enter the 9-digit LWEB-900 project PIN code and optional device PIN code. In order 

to connect this device to LWEB-900 choose Register Device as shown in Figure 45. 

 

Figure 45: Device VPN enrollment in LWEB-900 

5.3 Getting Started with the L-INX Configurator 

Before setting up a gateway, a working IEC61131 program or creating an L-WEB 

visualization, the data points of the L-INX automation server or the L-GATE need to be set 

up. These can be data points of L-IOB I/Os, network variables, BACnet objects, and other 

available technologies. Before executing the steps below, install the L-INX Configurator 

Software from the ‘setup.exe’. This file can be downloaded from www.loytec.com. 

To Start a Configurator Project 

1. Start the L-INX Configurator software by selecting Windows Start → Programs → 

LOYTEC LINX Configurator → LOYTEC LINX Configurator. The application 

starts up and displays the data point manager screen as shown in Figure 46. 

2. When the device is online, connect to the device by clicking on the Connect to device 

speed button as indicated by the red rectangle in Figure 46. 

http://www.loytec.com/
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Figure 46: L-INX Configurator main screen. 

3. For detailed information on how to create data points out of the network please refer to 

the LINX Configurator User Manual [2]. 

5.4 Getting Started with the Gateway 

The L-GATE and L-INX devices can be used as a gateway between any of the supported 

network technologies. This example gets you started with the gateway and shows how to map 

CEA-709 network variables from an LNS database to BACnet. The installer of the L-INX 

Configurator has already registered the L-INX Configurator as an LNS plug-in. This quick-

start assumes LonMaker TE as the LNS tool. 

To Configure a Gateway 

1. Open a new LNS database or open an existing LNS database. In the latter case you need 

to register the L-INX Configurator as an LNS plug-in in that database. 

2. Add your LONMARK devices to the LNS database. 

3. Add a new device using the device template for the L-GATE (e.g. ‘LOYTEC 

LGATE-950 FT-10’) or L-INX (e.g. ‘LOYTEC LINX-150 FT-10’) and commission the 

device. 

4. Right-click on the added device template and select Configure … This opens the L-INX 

Configurator as an LNS plug-in. 

5. Click on the Datapoints tab of the main window. 

6. Click on the button  Scan channel. This scans in all NVs on all devices connected 

to the CEA-709 channel of the device. 
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7. After the scan has completed, the folder LNS Database Scan is populated with the found 

NVs as shown in Figure 47. 

 

Figure 47: Result of an NV scan in LNS. 

8. Select the scanned NVs for use in the gateway and click on the button  Use on Device 

in the tool bar. 

9. The data points are created as dynamic NVs under the Datapoints folder of the 

CEA-709 Port folder. 

10. Select the NVs under the port folder, which shall be mapped to BACnet. Click on the 

speed button  Generate and connect selected in the tool bar. 

11. The generated BACnet objects appear in the Datapoints folder under the BACnet Port 

folder as shown in Figure 47. These objects are also automatically connected to the 

respective NVs. 

 

Figure 48: Auto-created BACnet Points in the BACnet Folder 

12. Then download the configuration into the device by clicking the Download 

Configuration speed button.  

 

  
 

13. After the reboot of the device value changes in the NVs are propagated to the connected 

BACnet objects and vice versa. 
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5.5 Configuration of the L-IOB I/O Modules 

The L-IOB I/O modules can be attached either directly to the LIOB Connect bus or to the 

LIOB-FT bus with standard TP/FT-10 wiring rules. Please visit the L-IOB I/O Module User 

Manual [7] for detailed hardware installation and terminal configuration instructions.  

The L-INX Configurator uses a separate tab to configure the L-IOB devices. The L-IOB 

device configuration can be done off-line and is shown in the following steps. 

To Configure L-IOB I/Os 

1. Add L-IOB devices on the LIOB tab from the supplied L-IOB templates using the Add 

Device(s) button  as shown in Figure 49.  

 

Figure 49: Add L-IOB devices to the LIOB Connect bus. 

2. Select a L-IOB device in the tree on the left-hand side and enter names for the terminals 

by double-clicking into the Name column as shown in Figure 50. 

 

Figure 50: Change L-IOB terminal names for your installation. 

3. Select a terminal and change the object parameters to configure this terminal. You can 

multi-select terminals and change the parameters for all selected terminals as shown in 

Figure 51. 

4. After setting all parameters, click on the Commit member changes button  to accept 

the changes. 
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Figure 51: Change L-IOB parameters for the selected terminal(s). 

5. On the Datapoints tab the data points for the LIOB terminals have been created. These 

data points can be used, e.g., in the IEC 61131 program. For terminal inputs the data 

point L1_x_UIy_Input_Read will be used to read an input terminal and for terminal 

outputs the data point L1_x_DOy_Output_Write will be used to set an output terminal. 

6. After downloading the L-INX configuration into the L-INX device, the L-IOB input and 

output terminals can be tested with the L-INX Web UI. An example is shown in Figure 

52. 

 

Figure 52: Test L-IOB inputs and outputs on the Web UI. 

5.6 Getting started with L-STUDIO 

L-STUDIO is the LOYTEC solution for integrated development of PLC programming, data 

point configuration, visualization and cross-device communication between resources in the 

runtime. L-STUDIO is used to engineer the entire system, not only single controllers. To 
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fully support integrated cross-cmmunication, the L-STUDIO runtime requires IP-based 

communication. 

For developing IEC61131 programs with L-STUDIO the following components must be 

installed: 

1. L-STUDIO setup package. This package installs the L-STUDIO software, which is 

needed to design PLC programs for the L-INX device. 

2. L-INX Configurator. This software is required to configure the L-INX device to provide 

the necessary data points to the PLC and integrate the device into the network. 

3. L-VIS Configurator. This software is required to create graphics for the CAT (composite 

automation type). The CAT combines data points, PLC logic, and graphics in one 

component. 

4. L-STUDIO runtime license installed on the LOYTEC controller device. Most L-INX 

devices come with a pre-installed license (see Section 1.12). 

The basic components in an L-STUDIO 61131 solution are: 

• 61131 program CAT: This contains the functions blocks, data points and sub-

function blocks that implement the PLC logic. Logic in the 61131 program CATs is 

executed on a cyclic basis. 

• 61499 CAT: This composite block instantiates one ore more 61131 program CATs 

and creates the cyclic trigger signal for those blocks. 

• Device CAT: This represents a type for the controller equipment on which 61499 

CATs can be instantiated. On the device CAT, L-IOB I/Os can be links to favorites 

that have been generated out of the 61131 CATs. 

• Device Resource: This is the physical representation of the controller equipment. 

This quick-start guide walks you through the basic steps to create a first simple PLC program 

in L-STUDIO 61131. For a thorough discussion of the components needed in an L-STUDIO 

61131 application the LTRAIN-LSTUDIO training course must be attended. The training 

material goes into more detail on how to use LOYTEC library components and instantiate 

CATs for visualization.  

To Start an L-STUDIO Project with a 61131 program 

1. After installing the necessary software components start the L-STUDIO application from 

the Windows start menu.  

2. Create a new solution in menu File → New → Solution… and enter a name as shown 

in Figure 53. 
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Figure 53: Create a new L-STUDIO solution 

3. This create a blank solution named ‘KickStart’ as shown in Figure 54 

 

Figure 54: Blank L-STUDIO solution. 

4. Create a 61131 program CAT: In the ‘KickStart’ solution tree, select CAT → 

Application. Then right-click and choose New Item. Select IEC61131 CAT, enter a 

name, and select Program as implementation and Continuous Function Chart. Then 

click Finish as shown in Figure 55. 
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Figure 55: Create a 61131 program CAT. 

5. Open ‘MyPGM’ and go to the Configurator tab. This opens the Configurator for this 

IEC 61131 program. Create data points as needed, e.g., reg1, reg2, reg_sum. Set PLC 

in on reg1 and reg2 and set PLC out on reg_sum as shown in Figure 56. Click on Save 

in the toolbar. 

 

Figure 56: Setting PLC in and out on data points in the Configurator 

6. Change to the Program tab. The created PLC data points show up in the VAR list as 

shown in Figure 57. 

 

Figure 57: VAR list in the program CAT. 
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7. In the drawing area below create an ‘ADD’ function block by Ctrl+W and typing ‘ADD’. 

Right-click on IN1 and select Add Internal Var. Type ‘reg1’ as the VAR name and 

save. Do the same for IN2 and reg2, and ADD and reg_sum as shown in Figure 58. 

 

Figure 58: Create simple logic in the 61131 program. 

8. Click Save in the toolbar. This creates a first simple 61131 program. It can be extended 

by 61131 function blocks. 

9. The program CAT is really a 61499 CAT with the TASKIN event as the only input event. 

It is the “bridge” between the IEC 61499 (outside) and IEC 61131 (inside) programming. 

It allows to combine IEC 61499 and IEC 61131 functionality in a single device. 

10. To embed the program block into the 61499 runtime, create a normal CAT: In the 

‘KickStart’ solution tree, select CAT → Application. Then right-click and choose New 

Item. Select Normal CAT and type in a name. Then click Finish as shown in Figure 

59. 

 

Figure 59: Create a 61499 CAT to embed the 61131 program. 

11. Now create a clock signal for IEC61131 programs: Open the new CAT ‘MyCAT’ and 

select the Composite tab. 

12. Create the E_RESTART and E_CYCLE function blocks: This can be done by Ctrl+W 

and typing E_RESTART as the new element type. That opens a drop-down list as you 

type. Choose the E_RESTART item and hit Enter. This creates the E_RESTART 

function block. Repeat this for the E_CYCLE block. 
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Figure 60: Embed the 61131 program in a 61499 CAT. 

13. Connect the COLD and WARM Restart outputs to the START input by drag-and-drop 

between the function blocks as shown in Figure 60. 

14. Right-click on the DT input of the E_CYCLE block, choose Add Constant and set it to 

‘T#100ms’. 

15. Delete the lweb block. That block is used only in native 61499 applications and is not 

used in 61131. 

16. Drag and drop the ‘MyPGM’ block from the solution tree onto the ‘MyCAT’ composite 

tab. This creates a program instance. Then connect the EO output to the TASKIN of the 

program block. Multiple instance of a program are possible. In this case connect the 

TASKOUT to TASKIN of the next instance. 

17. As a next step it is necessary to create a device type. In the ‘KickStart’ solution tree, 

select CAT → Application. Then right-click and choose New Item. Select Device CAT, 

enter a name and choose the device model, e.g. LINX-153, as shown in Figure 61. 

 

Figure 61: Create a new device CAT. 
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18. Open the device ‘MyLinx’ and go to the Composite tab. Drag the ‘MyCAT’ from the 

solution tree onto the composite tab to create a CAT instance (see Figure 62). You may 

also delete the ‘lweb’ block as it is not needed. 

 

Figure 62: Create a CAT instance within the device CAT. 

19. Finally create a device instance. Open the System  in the toolbar. Then select the 

Network tab. Drag the ‘MyLinx’ device from the solution tree onto the network tab and 

assign a name to the device instance as shown in Figure 63. 

 

Figure 63: Create a device instance. 

20. Select the Devices tab. Then click on the Device dropdown and choose Device CATs… 

in order to create the device resources (see Figure 64). 

 

Figure 64: Create device resources in the system. 

21. In the list, select all devices that apply and click Create Devices (see Figure 65). 
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Figure 65: Select devices to be created. 

22. Edit the IP address, login credentials for the device as shown in Figure 66. Then click 

Save in the toolbar. 

 

Figure 66: Enter IP address and credentials for the device resource. 

23. To test click on the Get status button as shown in Figure 67. The Status column should 

now show OK. 

 

Figure 67: Test connection to the device resource. 

24. Deploy the application: Right-click on the device. In the context menu, choose Deploy 

→ Deploy. The program is compiled and then deployed onto the device. 

25. The device will reboot and come up with the new program. Open the Web UI on the 

device and verify the add function as shown in Figure 68. Note, that two folders have 

been generated for the two 61131 program instances (MyPGM1, MyPGM2). 

 

Figure 68: Resulting data points on the device. 

5.7 Getting started with logiCAD 

For developing IEC61131 programs with logiCAD the following components must be 

installed: 

1. L-logiCAD setup package. This package installs the logiCAD software, which is needed 

to design PLC programs for the L-INX device. 
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2. L-INX Configurator. This software is required to configure the L-INX device to provide 

the necessary data points to the PLC and integrate the device into the network. 

3. logiCAD license for using logiCAD on the PC. The license is available as a softlock 

version or as a hardlock version with a USB dongle. On virtual machines it is mandatory 

to use the hardlock license. 

A detailed guide on how to install the software components described above and upgrade of 

an older license can be found in Section 8.2. 

To Start a logiCAD Project 

1. After installing the necessary software components start logiCAD from the L-INX 

Configurator by clicking the Start LogiCAD speed button.  

 

  
 

2. The project wizard starts automatically as shown in Figure 69.  

 

Figure 69: logiCAD project wizard 

3. Select Create new project and press Next. 
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Figure 70: Available project templates 

4. Select the project template for the L-INX device (e.g., LINX-11x or LINX-12x). 

 

Figure 71: Project name and path 

5. Specify the name of the project and the path where to store the project files, see Figure 

71. 
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Figure 72: Additional information 

6. After specifying additional information the new project is created by pressing the Finish 

button. 

7. As shown in Figure 73 below, expand the tree element Functionplans and double click 

Plan_1 in order to start editing the plan. 

 

 

Figure 73: Edit Plan_1 

8. In the new LogiCAD project there are no external variables yet. To expose data points 

from the L-INX to the logic program, activate the PLC check box of the corresponding 

data points in the Configurator, e.g., the L-IOB I/Os of the universal input or any other 
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data point such as a network variable, user register or BACnet object.  

 

  

 

9. When you have completed selecting the PLC data points, click the Export variables to 

LogiCAD speed button while LogiCAD is running.  

 

  
 

10. The data points now appear as variables in LogiCAD in a folder under the device folder. 

The folder is named specific to the technology of the data points, e.g. LIOB for all L-IOB 

I/Os that are exposed as a PLC variable. An example is shown in Figure 74. 

 

Figure 74: Exposed PLC data points appear in LogiCAD 

11. Now the logic can be developed on the function plan. 

12. For later debugging, it is good practice to add online test fields to the drawing, to display 

the current value of the signals during online test. To do this, right-click on the value 

output of the left function block and select Create OLT Field from the context menu, 

as shown in Figure 75. 

 

Figure 75: Create online test fields 

13. Place the fields above and below the drawing as shown in Figure 76, then press the Save 

button to save your changes. 
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Figure 76: Online Test fields 

14. Finally, open the context menu of the LINX-11x device again and select Code 

Generation. In the dialog, press the button Start to start the code generation process. 

On success, the code generation window reports Errors=0 and Warnings=1. 

15. Close the window by pressing the OK button. Now the compiled IEC61131 program 

can be downloaded to the device. Right-click the tree element LINX-11x and select 

Download from the context menu. A connection dialog will appear and ask for the type 

of connection and additional information. 

 

Figure 77: IEC61131 program download 

16. Select the TCP/IP communication driver and enter the target address as configured in 

Section 5.2. Start the download process by pressing the OK button. 

17. After the download completed check the PLC LED. If it is steady green, the logic is not 

yet running. Reboot the L-INX to start the IEC61131 program. 

5.8 Connect with an OPC XML-DA Client 

After the configuration has been downloaded to the L-INX it is ready to serve OPC XML-

DA clients. All data points with the OPC check box activated will be exposed. Connect to 

the L-INX using the URL 

http://192.168.24.99/DA,  

http://192.168.24.99/DA
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given that 192.168.24.99 is the IP address of the device. Note, that by default, writing to OPC 

tags needs basic HTTP authentication using the password for the operator user. This is 

‘operator’ by default. 

5.9 Reset to Factory Defaults 

In case the password of the device or the PIN code of the LCD UI has been forgotten you 

may need to reset the device back to factory defaults to gain access again. On the L-INX 

models 10X, 11X, 20X, 21X press the service button and power-cycle the device. On the 

L-INX models with the jog dial press the jog dial and power-cycle the device. Keep the 

button/jog dial pressed until the port LEDs illuminate orange permanently. Release the 

button/jog dial within five seconds from that time on to reset the device to factory defaults. 
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6 Hardware Installation 

6.1 Enclosure 

The enclosure of the product and its terminal layout are shown on the installation sheet found 

in the product’s box. 

6.2 Product Label 

The product label on the side of the L-INX/L-GATE contains the following information (for 

an example see Figure 78): 

• L-INX order number with bar-code (e.g. LINX-112, LGATE-950), 

• serial number with bar-code (Ser#). 

 

Figure 78: Example product label. 

Unless stated otherwise, all bar codes are encoded using “Code 128”. An additional label is 

also supplied with the device for documentation purposes. The specific contents of the 

product label are shown on the installation sheet found in the product’s box. 

6.3 Mounting 

The device comes prepared for mounting on DIN rails following DIN EN 50 022. The device 

can be mounted in any position. However, an installation place with proper airflow must be 

selected to ensure that the device’s temperature does not exceed the specified range (see 

Chapter 13). 
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6.4 LED signals 

Available LEDs and their location on the respective device model can be found on the 

product’s installation sheet. The installation sheet can be found in the product’s box. 

6.4.1 OPC LED 

The OPC Server LED illuminates green when at least one OPC client is connected to the 

OPC server. The LED flickers on OPC XML-DA traffic activity. 

6.4.2 PLC LED 

The PLC LED indicates the state of the IEC61131 kernel and the IEC61131 program (see 

product installation sheet). Table 3 shows the different LED patterns and their meaning. 

Behavior Description Comment 

GREEN permanent The IEC61131 program has 

been stopped 

The IEC61131 kernel is running, there is 

an IEC61131 program, but the program 

execution was stopped. 

GREEN flashing slow 

at 1 Hz 

Normal condition, IEC61131 

program running 

The IEC61131 kernel and program were 

successfully loaded. The IEC61131 

program is executed. 

GREEN flashing fast in 

an on-on-pause pattern 

I/O driver disabled The I/O driver is disabled, that is that no 

updates from or the IEC61131 program 

were handled. 

GREEN flashing fast CPU overload CPU load exceeded 80%. Modify the 

PLC program to reduce CPU load in 

order to guarantee normal system 

operation (for example, reduce the cycle 

time of the program). 

OFF No IEC61131 program No IEC61131 orogram is loaded or a 

problem occurred while starting the 

IEC61131 kernel. 

Table 3: PLC LED Patterns 

6.4.3 FT Activity LED 

The FT port on the device has a three-color LED (green, red, and orange, see product 

installation sheet). Table 4 shows different LED patterns of the port and their meaning. 

Behavior Description Comment 

GREEN flashing fast Traffic  

GREEN flashing at 1Hz The OPC node or LINX-101’s router port is 

unconfigured 

On the LINX-101 this LED only 

stops flashing if both, node and 

router, are commissioned. 

RED permanent Port damaged  

RED flashing fast Traffic with high amount of errors  

RED flashing at 1 Hz 

(all ports) 

Firmware image corrupt Please upload new firmware. 

ORANGE permanent Port disabled e.g., using LSD Tool 

ORANGE flashing fast Traffic on port configured as management port e.g., using LSD Tool 

Table 4: CEA-709 Activity LED Patterns. 
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6.4.4 MSTP Activity LED 

The MS/TP port has a three-color MSTP Activity LED (see product installation sheet). Table 

5 shows the different LED patterns of the port and their meaning. A permanent color reflects 

a state. Flicker is for 25 ms when there is activity on the MS/TP data link layer. 

Behavior Description Comment 

GREEN permanently, 

flicker off 

Multi-Master, token ok, flicker when traffic Normal condition on a multi-master 

MS/TP network. 

ORANGE flicker Sole master, flicker when traffic Normal condition on a single-master 

MS/TP network. 

RED permanent, flicker 

GREEN 

Token lost state, flicker when transmit 

attempt 

Cable might be broken. 

RED flash fast Transmission or receive errors This indicates bad cabling. 

Table 5: MS/TP Activity LED Patterns. 

6.4.5 Modbus LED 

The Modbus LED is a three-color LED. Table 6 shows the different LED patterns of the port 

and their meaning. Flicker is for 25 ms when there is activity on the bus. 

Behavior Description Comment 

GREEN flicker Traffic, transmission successful Normal condition. 

RED flicker Traffic, transmission unsusccesful Device not responding or other 

network error. 

Table 6: Modbus Activity LED Patterns. 

6.4.6 EXT LED 

The EXT port has a three-color LED (see product installation sheet), which displays link and 

traffic information on the protocol enabled on the port (M-Bus or KNX TP1). Table 7 shows 

the different LED patterns of the port and their meaning. A permanent color reflects a state. 

Flicker is for 25 ms when there is activity on the attached network. The LGATE-951/952 and 

the LINX-153 have more than one EXT port that all conform to the described behavior. 

Behavior Description Comment 

GREEN permanently, 

flicker off 

LKNX-300 attached, flicker when traffic Normal condition on a KNX TP1 

network. 

GREEN flash fast M-Bus traffic Normal condition on an M-Bus 

network. 

RED permanent LKNX-300 not attached, no KNX bus 

power or port damaged 

Check if cabling to LKNX-300 is 

bad. 

RED flash fast M-Bus transmission or receive errors This indicates bad cabling. Check if 

L-MBUS is connected. Check if 

M-Bus devices are operational. 

Table 7: EXT port LED Patterns. 

6.4.7 Ethernet Link LED 

The Ethernet Link LED lights up green whenever an Ethernet cable is plugged-in and a 

physical connection with a switch, hub, or PC can be established. 

6.4.8 Ethernet Activity LED 

The Ethernet Activity LED lights up green for 6 ms whenever a packet is transmitted or 

received or when a collision is detected on the network cable. 
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6.4.9 BBMD LED 

This LED is available on LGATE-95X only. The BBMD LED is permanent green if BBMD 

is enabled. Otherwise, it is off. 

6.4.10 Wink Action 

If the CEA-709 device receives a wink command on any of its network ports, it shows a blink 

pattern on the CNIP and the CEA-709 activity LEDs. The CEA-709 activity and the CNIP 

LED turn green/orange/red (each 0.15 s). This pattern is repeated six times. After that, the 

CNIP LED flashes orange six times if the wink command was received on the IP channel or 

the CEA-709 activity LED flashes orange six times if the wink command was received on 

the CEA-709 channel. After that the device’s LEDs resume their normal behavior. 

6.4.11 Network Diagnostics 

The CEA-709 device provides simple network diagnostics via its CEA-709 activity LED: 

If the LED does not light up at all, this port is not connected to any network segment or the 

connected network segment currently shows no traffic. 

If the LED is flashing green, the network segment connected to this port is ok. 

If the LED is flashing red, a potential problem exists on the network segment connected to 

this port. This state is referred to as overload condition. 

A port overload condition occurs if 

• the average bandwidth utilization of this port was higher than 70 %, or 

• the collision rate was higher than 5 %, or 

• more than 15 % CRC errors have occurred on a port with a power-line transceiver, or 

more than 5 % on a port with a transceiver other than power-line, or 

• the device was not able to process all available messages. 

For a deeper analysis of the reason for the overload condition, it is recommended to use a 

protocol analyzer (e.g., LOYTEC’s LPA) or a similar tool. The exact reason of the overload 

condition can also be determined with the LSD Tool. 

6.5 Wiring 

The wiring information of the product and its terminal layout are shown on the installation 

sheet found in the product’s box. 
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7 Concepts 

7.1 Universal Gateway 

The operating principle of a universal gateway is to connect data points of one network 

technology to data points of another technology. This is the primary function of the L-GATE 

product family. Gateway function are, however, also available in the L-INX family. 

Data points in the CEA-709 network are known as network variables (NVs). Data points in 

the BACnet technology are known as BACnet server objects. They have a specific type (e.g. 

analog input or binary output) and a set of properties, which describe the data point more 

closely. The actual value is stored in the “Present_Value”. For more information on the 

mentioned technologies refer to the LINX Configurator User Manual [2]. 

The typical task in configuring the universal gateway consists of the following steps: 

1. Selecting the data points of the network to be mapped (e.g., select the NVs in the 

CEA-709 network nodes or create new NVs) 

2. Select or create matching counterparts of the other technology (e.g., create matching 

BACnet objects) 

3. Create connections between the data points (e.g. connect NVs and BACnet objects). 

The connection is the central part of the gateway functionality. It defines, which data points 

are mapped to which data points. Refer to the Connections Section in the LINX Configurator 

User Manual [2] for more information. 

7.2 Data Point Configuration 

Data points are part of the fundamental device concept to model process data. A data point 

is the basic input/output element on the device. Each data point has a value, a data type, a 

direction, and a set of meta-data describing the value in a semantic context. Each data point 

also has a name and a description. The entire set of data points is organized in a hierarchy 

using a folder structure. Folders can be created as needed and have a folder name and 

description. 

The direction of a data point is defined as the “network view” of the data flow. This means, 

an input data point obtains data from the network. An output data point sends data to the 

network. This is an important convention to remember as different technologies may define 

other direction semantics. If a data point can both receive and send data on the network, its 

direction is set to value, indicating no explicit network data flow. 

The device provides a Web interface for displaying and modifying data point values (see 

Figure 79). Data points that are structures contain their structure members as sub-data points 

beneath them. Data point values are typically written by the controller or by the network. For 

testing purposes the values can also be manually overridden (Set Override). More 

information on the data point Web interface can be found in the LOYTEC Device User 
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Manual [1]. For a comprehensive description of the data point configuration on the device 

please refer to the LINX Configurator User Manual [2]. 

 

Figure 79: Data points on the Web interface. 

7.3 IEC61131 Variables 

IEC61131 variables are dedicated data points used to exchange data with the L-LOGICAD 

IEC61131 program. These variables are represented in the data point configuration as register 

data points and can be connected to other data points, e.g. to CEA-709 NV points, via data 

point connections. 

Another way to use data points in a 61131 program is to set the PLC in and PLC out flags on 

the respective data points.  

In contrast to CEA-709 or BACnet variables, IEC61131 variables are always represented as 

single data point. In case of scalar values (representing CEA-709 scalar or enumeration types) 

one of the following basic data types might be used: 

• Double: A register of base type double is represented by an analog data point. It can 

hold any scalar value. No specific scaling factors apply. 

• Signed Integer:  A register of base type signed integer is represented by a multi-state 

data point. This register can hold a set of discrete states, each identified by a signed stats 

ID. 

• Boolean: A register of base type boolean is represented by a binary data point. This 

register can hold a Boolean value. 

Structured IEC61131 variables, representing for example structured NVs, or customer 

defined IEC61131 structures, are stored as user type: 

• User: A user data point contains un-interpreted, user-defined data. The data is stored as 

a byte array. A user data point does not include any other meta-data. This type of data 

point also serves as a container for otherwise structured data points and represents the 

entire data structure. User data points can only be connected to other user data points of 

the same data length. 
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8 IEC 61131 – L-LOGICAD 

To design the IEC61131 program which should run on the L-INX device, the graphical 

programming tool logiCAD is required. The tool allows creating IEC61131 programs using 

various IEC61131 programming languages. It offers additional features downloading and 

debugging of the created program. 

In addition to logiCAD, the L-INX Configurator necessary to create an appropriate data point 

configuration in the automation server. The usage of logiCAD itself is beyond the scope of 

this manual. Please refer to the logiCAD online help in case of additional questions. 

8.1 Overview 

The PLC in the L-INX device is intended to perform IEC61131 programs operating on 

IEC61131 data points. The operating principle is to connect IEC61131 data points to data 

points derived from CEA-709, BACnet or LIOB network. Figure 80 depicts the usage of data 

points for IEC61131 programs at the example of using CEA-709 network variables. 

CEA-709

variables
IEC61131 program

CEA-709

variables

Input NVs DP DP Output NVs

IEC61131

variables

IEC61131

variables

 

Figure 80 Usage of data points. 

Alternatively, data points can also be directly exposed as IEC61131 variables. The data points 

provide a PLC check box for this purpose. In this use case, not special IEC61131 data points 

are created and no connections are necessary. 

In order to run a logiCAD PLC program on a L-INX controller, the L-LOGICAD license 

must be installed on the controller device. Note, that for newer devices as of production week 

50/2023 (A64 models) the L-LOGICAD license is no longer available. The following 

sections on logiCAD are therefore describing a legacy technology for L-INX controllers. For 

new projects, PLC programs need to be migrated to the L-STUDIO 61131 run-time. 

8.2 Installing logiCAD 

For developing IEC61131 programs with logiCAD the following components must be 

installed: 

1. L-logiCAD setup package. This package installs the logiCAD software, which is needed 

to design PLC programs for the L-INX device. 

2. L-INX Configurator. This software is required to configure the L-INX device to provide 

the necessary data points to the PLC and integrate the device into the network. 
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3. logiCAD license for using logiCAD on the PC. The license is available as a softlock 

version or as a hardlock version with a USB dongle. On virtual machines it is mandatory 

to use the hardlock license. How to obtain and install the license is described in this 

Section. 

The L-logiCAD installer installs the IEC61131 programming environment logiCAD and all 

L-INX related software packages. These packages include the template project for the LINX, 

the required software to build IEC61131 programs for the L-INX device, and required 

extensions to interface to CEA-709 networks. Follow the instructions of the installer to install 

logiCAD for the L-INX. 

The language for the logiCAD user interfaces can be set to German or English using the 

administration folder of the logiCAD control center. The logiCAD control center can be 

started from the Windows start menu. 

8.2.1 Softlock License 

The license to run a copy of logiCAD on any PC is based on a softlock license. In case the 

original softlock license file was generated for an older L-logiCAD version, the software will 

request an update signature key for the new L-logiCAD installation. This signature key can 

be found in the file ‘logicad_Readme.txt’ that is located in the installation directory of the L-

logiCAD software. 

To obtain and install a new license start logiCAD. The product activation dialog will appear 

as shown in Figure 81. In this dialog press the button Download Softlock License. 

Important!  When using Windows7 start logiCAD as administrator in order to allow the script read the 

computer number code. If there are x's in the code, the code was not read by the script. 

 

Figure 81: logiCAD Product Activation 

Enter the license data provided with the product information on the Web site form as shown 

in Figure 82. Fill in the SL-number and Licensing Code from your L-LOGICAD 

registration form and click on Download License File. Save the license file on your computer 

or have it e-mailed to you. 
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Figure 82: logiCAD softlock license Web form. 

Then install the license using the Install Softlock License button in the product activation 

dialog as indicated in Figure 83. 

 

Figure 83: logiCAD softlock installation. 

A file requestor dialog opens. Locate the downloaded license file (logicad.lf) and click Open. 

Finally click Close in the product activation dialog and start logiCAD again. The softlock 

license is now activated. 

8.2.2 Hardlock License 

The hardlock license is needed to run a copy of logiCAD in a virtual machine on the PC. It 

needs to be puchased separately as L-LODICAD-USB and is distributed as a USB hardlock 

key of type ‘CodeMeter’. If no driver for this type of hardlock is already installed on the PC, 

install the hardlock driver provided on the LOYTEC website. It can be found in Support → 
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Download and the product selection for L-LOGICAD. After the driver installation has 

completed, plug in the USB key. It must be recognized as a mass storage device (the details 

on it show the location ‘CodeMeter-Stick’). When starting logiCAD it recognizes the 

hardlock automatically. 

If the driver installation failed, or the USB key was not detected or connected, the window 

shown in Figure 84 will be shown when logiCAD is started. In this case plug in the hardlock 

stick, wait for Windows to recognize it and then click Find Dongle. 

 

Figure 84: logiCAD Product Activation with Hardlock 

Note:  logiCAD checks frequently if the USB key is present. When unplugging the USB key, even if 

logiCAD was successfully started, all major features are automatically disabled. But there is 

no additional message for the user! 

8.3 IEC61131 Project Files 

In the L-INX Configurator select the LogiCAD Files tab to attach an IEC61131 program and 

a logiCAD project to the L-INX project. The tab is shown in Figure 85. 

If there is an IEC61131 program attached to the project, every time a new configuration is 

downloaded to the device, the L-INX Configurator asks, if the attached program should be 

downloaded as well. This way, no logiCAD is required to download a suitable IEC61131 

program in a separate step. The project designed in the L-INX Configurator can hold all 

necessary information to set up a running device: 

• IEC61131 data point configuration, 

• Data point configuration in the LINX, 

• Required connections, 

• IEC61131 program. 

The logiCAD project directory can also be attached to the L-INX configuration file, in order 

to include the logiCAD project sources from which the program was compiled. 
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Figure 85: IEC61131 Project Files. 

To attach an IEC61131 program or a logiCAD project select the file/folder to attach. The 

selected data will be attached automatically the project. It can be restored to disk by pressing 

the Restore to Disk button. During the development process the attached data may change 

several times. To update the attached data, located on the before provided path, press the 

Refresh button. 

Every time a logiCAD project is successfully compiled, the file MBRTCode.so, the compiled 

IEC61131 program, is copied to the public directory of the device resource for which the 

program was compiled. Select this file to attach it to the project of the Configurator. Note 

that the time and date of the file indicates the time of the last code generation. If logiCAD is 

not able to build a new program, the old file will not be deleted. 

The project will be scanned for device resources and the available devices will be listed in 

the dropdown box called Device Config. Select the desired device and press the button 

Attach Program to automatically attach the correct MBRTCode.so file. 

8.4 Working with logiCAD 

This section provides all necessary background information how to use the L-INX with 

logiCAD. For using the L-INX with logiCAD, a predefined project template for the L-INX 

must be used. Hence, when creating a new project, select the project template “Project for 

LINX-110”, see Figure 86. For additional information how to create, delete and manage 

projects please refer to the logiCAD online help.  
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Figure 86: L-INX specific extensions 

Figure 86 shows the standard project for the L-INX including all LINX-specific extensions 

for logiCAD. It shows the structure window showing the project structure on the left, an 

empty working area top right and the Error-state viewer on the bottom right side. 

The structure window offers interfaces to the following features: 

1. The folder Functionplans holds all the program types created within logiCAD. ‘Plan_1’ 

is the default plan to start with. 

2. The folder LOYTEC/LINX-110 represents the LINX-110 device. The folder LOYTEC 

represents a configuration containing one LINX-110 resource; please refer to the 

logiCAD online help for details. To run a program, located in the folder Functionplans, 

a program instance of the corresponding function plan must be created. In the standard 

LINX-110 template a program instance of the ‘Plan_1’ is already defined. To be able to 

transfer IEC61131 variables from the L-INX device to the IEC61131 program a global 

variables object within the LINX-110 folder is required, see Section 8.4.1 for details.  

3. LogiCAD operates on variable types standardized in the IEC61131 standard. Look for 

“Elementary and Generic Data Types” within the logiCAD online help to get 

information about the available data types. For those L-INX devices, which are intended 

to operate on structured NVs, appropriate type definitions for the NVs are required. 

These definitions are inside the folder CEA-709_Types. Additional NVs must be 

converted to data types that can be processed by logiCAD. Therefore Technology 

Converters are supplied with the L-INX project, which perform this conversion. See 

Section 8.4.3 for details. 

4. For designing programs that support the force update functionality (see Section 8.6.1), 

or designing user-defined Technology Mapper (see Section 8.6.2) additional function 

blocks are required. These blocks are located within the Loytec_Support directory. 

All LINX-specific add-ons are provided using function blocks. Hence, in the following, all 

samples are based on designs using function blocks. 
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8.4.1 Managing Variables 

On a function plan, three basic types of variables may be created using the tabs shown below 

the function plan sheet: 

• VAR: Variables created on this tab will be visible only to the logic designed on this 

group of sheets. It will not be accessible to any other programs or to any function blocks 

which are used in this program. It is similar to a ‘static’ variable declaration in a C code 

function. 

• VAR GLOBAL: Variables declared here will be accessible to the entire program, 

including any function blocks which are called by the program. Function blocks which 

need to reference this variable need to have a suitable declaration of an external variable 

(see next point). This declaration is similar to a ‘static’ declaration of a C variable outside 

a function, which will be visible to all functions inside the C code module, but not visible 

to other modules. 

• VAR EXTERNAL: Variables declared in this list will be treated as open references to 

a global variable which exists somewhere in the scope of the device on which the 

program will be executed. This means that a global variable needs to be declared on the 

device resource, which will be available to all programs running on the device. If the 

physical address parameter of the variable is set to %I, %O, or %M, the variable will be 

handed down to the I/O driver of the L-INX for processing. If a suitable IEC61131 

variable exists in the data point configuration of the device, its value will be forwarded 

by the I/O driver between the PLC variable and the data point. If no physical address is 

set, the variable will only be visible to the PLC programs but not to the I/O driver, which 

may be used to exchange data between PLC tasks.  

The basic data flow between the CEA709 network (or BACnet and other technologies) and 

the PLC program is depicted in Figure 87. 
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Figure 87: Connecting IEC61131 variables 

The place where global variables are created on the device is shown in Figure 88. 

 

Figure 88: Global Variables Object 

When starting a new project, no global variables object is available; it must be created before 

compiling the IEC61131 application. The global variables object is created automatically by 

the LINX Configurator when exporting variables to logiCAD. 
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Figure 89: Variables defined in global variables object 

Figure 89 shows the contents of a sample global variables object. As shown a global variable 

is defined by the fields name, declaration and phys.addr.: 

• Name: The name of a global variable must be unique. The name is used from the IO 

driver to identify the global variable and from the L-INX Configurator to generate the 

corresponding IEC61131 data points. 

• Declaration: Here the type of the global variable is defined. 

• Phys.Addr.: The IO driver needs to know the data flow direction to be able to update 

variables. The direction is defined by adding %I for an input variable, %O for an output 

variable and %M for a marker (input and output). If the address is empty, the I/O driver 

will not handle the variable, but it may still be used by the tasks running on the device. 

Important: Only ASCII characters can be used for naming the global variables. 

8.4.2 Build and Download the IEC61131 Program 

IEC61131 programs, designed using logiCAD, must be cross compiled in order to run on the 

L-INX device. The prerequisite to compile an IEC61131 program are as follows: 

• A program instance with associated program type 

• A corresponding global variables object 

Right click on the LINX-110 resource, see Figure 88, and select Code Generation. Please 

refer to the logiCAD online help for the meaning of the options. Take care about the option 

breakpoint support, see section 8.4.5 for details. 

After successfully finished code generation, the IEC61131 application can be downloaded to 

the LINX-110. Right click on the LINX-110 resource and select download. 

The IEC61131 program can be downloaded to the LINX-110 device via TCP/IP, CEA-709 

and RS232: 

• TCP/IP: Enter the IP address of the LINX-110 device. Do not change the default 

communication port (2048). This is the easiest and fastest way to connect to the device. 

• CEA-709: Select the network interface to use and fill out all other fields, see Figure 90. 

Alternatively, select the network interface and press Auto-detect via Service-Pin. Then 

press the service pin on the LINX-110 device. Note that this connection method requires 

an installed LOYTEC network interface. 



L-INX/L-GATE User Manual 96 LOYTEC  

Version 8.4  LOYTEC electronics GmbH 

 

Figure 90: Connect via CEA-709 

Important: To be able to communicate with the LINX-110 device via CEA709 the LINX-110 must be 

commissioned. 

• RS232: To connect via RS232 select LOYTEC RS232 as Driver and LOYTEC as 

transmission protocol. All other values are set correctly per default. 

8.4.3 Usage of NVs, Technology Converters 

To used CEA-709 variables the content of the NVs must be converted to IEC61131 compliant 

data types. Look for “Elementary and Generic Data Types” within the logiCAD online help 

to get information about the available data types. Technology Converters are used to perform 

the transformation from CEA-709 data types to IEC61131 data types. All Technology 

Converters are summarized in the subfolder CEA709_Conv located in the StandardLibs 

folder.  

Depending on the type of the NV there are three different ways to use the NV within 

IEC61131 programs: 

• Simple NVs that hold only one scalar value, e.g. SNVT_amp: 

Those kinds on NVs are represented as IEC61131 REAL values within logiCAD. 

There is no additional conversion necessary. Figure 102 shows an example program 

for scalar data types. 

• Simple NVs based on an enumeration, e.g. SNVT_date_day: 

The active identifier of the enumeration is represented as Boolean value. When 

using NVs based on enumerations, Enumeration Converters are used to identify the 

current state. There are two kinds of Enumeration Converters. First, the 

Enumeration Converters that convert the enumeration types to Boolean types, 

grouped in the folder Convert from CEA709_Enums. Second, the Enumeration 

Converters that converts several Boolean inputs to an enumeration type, grouped in 

the folder Convert to CEA709_Enums. 

• Structured NVs that consists of a number of fields, e.g. SNVT_switch: 

On structured NVs two tasks must be performed by the Technology Converters. 

First the structure of the NV is mapped to IEC61131 conform data types. Second, if 

necessary scaling factors are applied. Similar to the Enumeration Converters, the 

Technology Converters are split up into two subfolders. The first one, which 
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converts the NV into IEC61131 compliant data types, is located in the folder 

From_CEA709_Types. Technology Converters to set up NVs based on IEC61131 

data types are grouped in the folder To_CEA709_Types. 

Figure 91 shows the three possibilities how to use NVs within an IEC61131 program. 

 

Figure 91: Usage of NVs 

If a structured NV comprises enumerations types, these enumerations are not split up by the 

Technology Converter. To get the value of the enumeration, connect an Enumeration 

Converter to the corresponding output of the Technology Converter. 

For every Technology Converter and Enumeration Converter an online help window, 

displaying the interface description is available. Select the Technology Converter and press 

F1 to get the interface description. 

8.4.4 IEC61131 Program Cycle Time 

IEC61131 programs are performed in a periodical manner. IEC61131 tasks are used do 

control the execution of an IEC61131 program. As shown in Figure 88 several default tasks 

are defined within the template project. Right click on the clock symbol and select properties 

to change the cycle time of the task. 

As described in section 8.4 a program instance is required to execute the IEC61131 program. 

The cycle time of the IEC61131 program is controlled by the task assigned to the program 

instance. In order to change the cycle time right click on the program instance and select 

properties. In the upcoming window the task assignment for the selected program type can 

be changed, see Figure 92. 

 

Figure 92: Task assignment 

Please take care when defining names for the tasks. The names displayed in the project view 

are symbolic names, they do not correspond to the settings for the cycle time, even if the 

L-INX template project use the configured cycle time as task name. 
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8.4.5 CPU Overload 

Several conditions affect the CPU utilization of the IEC61131 program. As a result it is not 

possible to predict the system load caused by the IEC61131 program. E.g. the following 

parameters are of particular importance when designing IEC61131 programs: 

• Number of inputs and outputs handled by the I/O driver. 

• Complexity of the logic in the running IEC61131 program. 

• Number of simultaneously running program instances on one L-INX. 

• Cycle time of IEC61131 programs. 

• logiCAD breakpoint support and force-able code enabled or disabled 

The developer of the IEC61131 program is able to check the current system load within the 

Web UI. To get a rough estimate of the CPU load investigate the PLC-LED. Every time, the 

system load increases 80% for a certain period of time, the PLC-LED switches to red until 

the system load goes below 80%. 

In case of CPU overload, the IEC61131 program may not be able to finish its work within 

the defined cycle time. Adapt the program in order to reduce the total system load below 

80%. Here are a few tips to keep the CPU load down: 

• Increase the cycle time, so that the task may finish in time before the next cycle start 

is scheduled. The PLC kernel will always schedule the next run at an absolute time, 

no matter how long the previous run took, in order to compensate for irregular 

execution times and keep a steady cycle time if possible. 

• Reduce the number of I/O variables, to reduce the load caused by exchanging data 

between the PLC program and the data points of the automation server. 

• Reduce the number of independent tasks and try to place as much functionality as 

possible into one task. Every running task will call the I/O driver for new inputs and 

outputs independently, therefore two tasks running at a 1s cycle time each will cause 

twice the I/O load of one task running at 1s cycle time. 

• Take special care about the complexity of function blocks which are used a lot. Bad 

performance of one such block may dramatically increase CPU load if it needs to 

be calculated several hundred times in one cycle. 

• Try to disable breakpoint support and force-able code when generating code for the 

target, to get the most efficient PLC code out of your logic. 

• For complex designs, it may be possible to add a state machine using SFC elements 

and enable/disable large parts of the logic based on the current state of operation. 

• Whenever a function does not need to calculate new output values under certain 

conditions, use the built-in EN input of the block to disable execution and thus 

reduce the required CPU time, instead of adding your own ‘Enable’ input which 

causes the logic to ‘behave’ as if it would be disabled, while it is actually calculated 

every cycle. This is similar to power saving methods used in modern electronic 

devices. Parts which are not required are put into a low power mode instead of 

keeping them running in an unproductive state. 

8.4.6 I/O Driver Settings 

Before starting the IEC61131 program, the device performs a check on all defined global 

variables, which are marked %I, %O, or %M in the physical address parameter. For all 
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variables, which cannot be loaded, because the corresponding data points cannot be located 

on the device, the I/O driver reports a warning in the system log and shows a listing on the 

Web interface. 

Since IEC61131 program and the data point configuration are downloaded separately, it may 

be possible that the IEC61131 program does not match the currently active data point 

interface. In this case it could be dangerous to write values onto those potentially wrong data 

points. The fact that there are any variables that could not be loaded is taken as an indication 

for a configuration mismatch. The I/O Check feature disables the I/O driver of the IEC61131 

kernel automatically in this situation. This setting is enabled by default in a new 

configuration. In the rare case that it is intended to have missing data points, this feature can 

be disabled in the Configurator. In the system settings de-select the I/O check (see Figure 

93). If the I/O driver is disabled, it can be temporarily enabled again on the Web interface 

until the next reboot. 

 

Figure 93: System settings for logiCAD I/O settings. 

The project setting Enforce cyclic output update enables a cyclic update of output data 

points, which will ensure that those output data points will contain the calculated value after 

each cycle. This is the default setting. It can be disabled, if the output data point shall be 

written only if the calculated value changes. In this mode the output data point can be 

modified over the Web UI for debugging reasons until the IEC61131 program calculates a 

new value. This mode can also be used to implement an event-style output operation. 

8.4.7 PLC Conflicts 

PLC output variables are cyclically updating the respective data points, which are configured 

as PLC out. If those data points are also written to by other objects (e.g. output of a math 

object, receiver in a connection) this will not have the desired effect. Also favorites that are 

PLC out and linked to a PLC out data point will result in two different PLC output variables 

writing to one and the same data point. 

The PLC Conflicts tab provides information for detecting such write conflicts on PLC out 

data points. The tab shows a list of PLC write conflicts and the writing objects, which are in 

conflict with a PLC out data point. Each reported conflict line can be selected. By clicking 

the Go to data point button  the Configurator navigates to the conflicting object. 

 

Figure 94: PLC conflicts tab. 

An example is shown in Figure 94. The user register ‘HeatExchangeON_Write’ is written to 

by the PLC, because it is PLC out. But the register is also an output in the math object 

‘VE01_HeatExchange’. To resolve the conflict, either remove the register from the math 

object or remove the PLC out check box from the user register. For doing the latter, select 
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the conflict line reporting the register and select Go to data point. Then uncheck PLC out 

on the data point. 

8.5 Workflows for the L-INX 

8.5.1 Starting with Data Points 

This workflow is based on defining data points used for the IEC61131 program in the L-INX 

Configurator and then export them to logiCAD. Figure 95 presents the basic steps of this 

workflow. To follow the steps refer to the quick-start description of Section 5.7.  Refer to the 

LINX Configurator User Manual [2] about additional information how to gather information 

from the network. 

Start the Configurator

Scan network variables

Section 5.3.2

START

DONE

Download configuration to device

Section 4.4.4

Select NVs and use on device

Section 5.3.5

Expose data points via PLC check box

Start logiCAD

Export variables to logiCAD

Use (Drag&Drop) global variables in IEC61131 

program

 

Figure 95: Start with network based information 

It is assumed that there are already network data points (CEA-709, BACnet, L-IOB, etc.) 

available. Clicking the Export variables to logiCAD button in the Configurator creates the 

IEC61131 variables in logiCAD. The following rules are applied in this process: 

• The name of the global variables object is derived from the technology base folder 

(e.g. CEA709, User Registers, etc.). If there is no matching global variables object 
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one is created. If there is already a suitable global variables object, the existing 

variables are saved. 

• There is already a suitable global variables object: If there is an old and new variable 

with identical name, the type of the variable is checked. In case of a type mismatch 

of the old and new variable, the old one is discarded and the new one is imported. 

Additional a warning is printed on the Error-state viewer. 

• The name of the global variables object represents the folder name in the L-INX 

Configurator. 

After exporting the data points as global variables to logiCAD, they can be used in the 

Functionplan ‘Plan_1’. To open the respective global variables folder double-click on it. To 

use the imported variables simply drag and drop the required global variable on to the 

Functionplan, see Figure 96. The external variables (see Section 8.5.2) are automatically 

created when adding the global variable to the Functionplan. 

 

Figure 96: Adding global variables to Functionplans 

After adding function blocks that perform the expected work, the IEC61131 program is ready 

to compile and download (see Section 8.4.2). 

8.5.2 Starting with logiCAD 

This section introduces a workflow how to develop a new IEC61131 program from scratch 

using logiCAD. Figure 97 shows the necessary steps to perform. For starting a new logiCAD 

project refer to the quick-start of Section 5.7. 
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Create IEC61131 program with logiCAD

Generate IEC61131 variables

Start the L-INX Configurator

START

DONE

Download configuration to device

Section 6.6.4

Import IEC61131 variables from logiCAD

Select Generate and Connect NVs <-> 

IEC61131 Variables

 

Figure 97: Starting with logiCAD 

After creating a new project for a L-INX resource and opening the Functionplan Plan_1 an 

empty input area is shown, similar to Figure 98. 

 

Figure 98: Start new function plan 

The dark grey areas on the left and right side are intended to place the input and output 

variables, the light grey area is used to place the functional blocks. 

As described above, global variables are used to interface IEC61131 data points on the 

LINX-110 device. As assumed for the current workflow, the IEC61131 data points are 

created on information based on the global variables exported from logiCAD. Hence, for 

designing the program, external variables are used during the design phase. To create a new 
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variable select the VAR_EXTERNAL tab, right click in the declaration area and select New, 

as shown in Figure 99. 

 

Figure 99: New external variable 

In the upcoming dialog the name and the type declaration of the variable must be specified. 

The type declaration can be done directly by prompting the type into the declaration field, by 

selecting the type from the pull-down menu or by drag-and-drop of a specific type from the 

project tree, see Figure 100. Finally, the new variable is added by pressing the Add button. 
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Figure 100: External variable type declaration 

The created variable is added to the declaration area and placed to the drawing area by drag-

and-drop. At this time the direction of the external variable is not defined, it can be used as 

input as well as output variable. 

 

Figure 101: Drag-and-drop external variable to drawing area 

Please take care to use an external variable only as input OR output. After adding the external 

variables to the drawing area, add function blocks to perform the desired actions, see Figure 

102 for a sample configuration.  
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Figure 102: Use external variables 

The Functionplan ‘Plan_1’ represents now a simple program. It adds a defined value to the 

value of the input variable and sends the result to the output variable. 

Add all expected functionality to the ‘Plan_1’ or use different Functionplans to split up the 

expected functionality into smaller pieces. But take care about the name and type declaration 

of external variables when using more than one Functionplan. All external variables with the 

same name refer to the same global variable. 

After adding all functionality, global variables matching the requirements of the defined 

external variables, must be generated. A tool automatically performs the process of 

generating the global variables object and the required global variables. 

 

Figure 103: Auto-create global variables 

To start the creation of global variables, based on external variables, Save all changes, then 

right click the L-INX device and select Global Variables → Generate. Then the selected 

L-INX resource is parsed and every program instance found is checked for external variables. 

In Figure 103 the type instance Plan_1 refers to the Functionplan ‘Plan_1’, as defined in 

Figure 102. If there are more Functionplans than the predefined ‘Plan_1’ appropriate program 

instances for these plans must be added to the resource before creating the global variables. 

Anyway, only Functionplans referred from program instances are executed.  
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Figure 104: Created global variables object 

Now there is a global variables object called IEC61131 Variables available, containing all 

global representations of the external variables defined before. The Error-state viewer 

reports all processed program instances and added variables, see Figure 104 for details. 

The global variables are crated based on the following rules: 

• The direction of the variable is determined based on the graphical representation, 

shown in Figure 105.  

 

Figure 105: Direction of global variables 

Every external variable connected on the right terminal results in a global input 

variable. External variables connected on the left terminal or on both sides results 

in a global output variable. Variables connected on both sides can either be used for 

the force update feature (see section 8.6.1) or as marker (see section 8.6.4). As the 

tool can not distinguish between these two possibilities, per default a global output 

variable is created. 

• If there is already a global variables object, only new variables are added. In case of 

external variables using the same name as an already existing global variable, the 

new definition is used and a warning is printed in the Error-state viewer.  

• In case of two Functionplans, each referring to a global variable with the same name 

but a different type, the creation process is stopped and an error is printed in the 

Error-state viewer. 

Now the IEC61131 program is ready to compile and download, refer to section 8.4.2 for 

details. 

Based on the above created global variables corresponding IEC61131 data points are created 

on the L-INX. For doing so, start the L-INX Configurator and click the speed button  

Import variables from logiCAD. Data points are created in the IEC61131 Variables folder. 
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The Configurator reports the results of the import. For the import process the following rules 

are applied: 

• New variables are added 

• Variables with same name and type are ignored 

• If there are variables with the same name but different type or direction, the variable 

to import is ignored and a warning is added to the import log. 

The name of the folder to import the new variables corresponds to the name of the global 

variables object. Figure 106 shows the result of the import process. 

 

Figure 106: Connect IEC61131 variables 

To create the appropriate network data points for all imported IEC61131 variables select the 

IEC61131 Variables folder and press the button Generate and Connect Network <-> 

IEC61131 variable from folder. Check the log output for errors and finally download the 

configuration to the L-INX device. 

After rebooting the L-INX device the IEC61131 program is up and running. Check the PLC 

LED for potential overload. 

8.5.3 Pre-compiled IEC61131 Program 

In opposite to the last two chapters it is assumed that there are already some components 

finished, hence starting up from scratch is not suitable. Second, there is the possibility to have 

an already defined IEC61131 program or an already fixed network interface. 

Starting with an already precompiled IEC61131 program results in a similar workflow as 

presented in Section 8.5.1. The difference is that all logiCAD related tasks are missing. As 

the IEC61131 program is compiled, the name of the IEC61131 data points is already fixed. 

The definitions for the data points must be available either in form of a CSV file to import to 

the L-INX Configurator or as part of a L-INX Configurator project. If the network interface 

for the L-INX was not already defined, the L-INX Configurator can be used to generate and 

connect the needed data points. 
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Additionally, there is the possibility that also the network data points are already fixed or that 

a given, user-defined interface is necessary. Then the developer has to connect the IEC61131 

data points to the corresponding network data points by himself.  

Finally, after downloading the configuration and rebooting the L-INX, the IEC61131 

program can be downloaded to the L-INX via the Web UI or the L-INX Configurator. After 

a final reboot the L-INX loads and executes the IEC61131 program. 

8.6 Additional Features 

8.6.1 Force Update Functionality 

Per default the IEC61131 program only sends updates on changed output values. Every 

program cycle the input values are fetched, the IEC61131 program is executed and the 

calculated values are sent to the output driver. If the old values are identically with the new 

one no updates are sent to the IEC61131 data points. As a result no update is sent to the 

network. 

For some applications, e.g. for a scene controller, it is necessary to send an update on request. 

E.g. every time the input value is updated, the output value is forwarded to the network, 

regardless if the value of the output value was changed or not.  

For implementing this feature, special vendor blocks are available. First it is necessary to 

check if there was an update on a selected input within the last execution cycle of the running 

IEC61131 program. That functionality is offered by the function block Update Notify 

located in the StandardLibs→Loytec_Support folder. Second, an output must be forced to 

send an update even if the value was not changed. The function block Force Update is used 

for that functionality, it is located in the StandardLibs→Loytec_Support. 

 

Figure 107: Force update 

Figure 107 depicts how to use the force update functionality. Besides of the part of the 

IEC61131 program that defines the calculations to perform (lower half of Figure 107), 

additional logic for the force update functionality is required. The global input variable that 

is monitored for changes is connected to the Update Notification function block. As a result, 

the Boolean output ‘Updated’ is set to TRUE for one program cycle, if the value of the 

connected variable has been updated since the last cycle start. To force the I/O driver send 

out an update, the global output variable, which shall be updated, is connected to ‘Output’ of 

the Force Update block. Hence, every time the ‘Update’ input of the Force Update block is 

TRUE, the connected global output variable sends out an update at the end of the program 

cycle. 

Important: Every global variable connected to the update notification or force update block must be 

connected via the right-hand side terminal! 

8.6.2 Using UNVT variables 

Similar to the predefined CEA709 data types and the technology converter functions, user-

defined network variable data types can be used. The L-INX Configurator supports the 

developer to generate the type definitions needed for UNVTs and enumerations based on 

resources files. LONMARK 



L-INX/L-GATE User Manual 109 LOYTEC  

Version 8.4  LOYTEC electronics GmbH 

To generate type definitionf for UNVTs in logiCAD 

1. Start the L-INX Configurator. 

2. Select the menu Tools → Export NV Resource File…. 

3. Select the resource file to be exported. Select structured text as format and export the file 

to a location of your choice by clicking Export Selected.  

 

   

4. To import the created type definition file into logiCAD, add a new library to the project. 

Right-click on the created library and select Export/Import → Start ST-Import. 

5. Select the file to be imported and check the Error-state viewer for the results of the 

import process. 

Using the newly created data types, suitable technology converter function blocks can be 

created. For each UNVT type, create a normal function block to convert an input of the 

UNVT type to a number of standard IEC61131 data types and vice versa. You may look at 

the technology converter blocks for SNVT types which are provided by LOYTEC, to get 

ideas how to implement your own converter functions. 

8.6.3 Create Your Own Data Type 

For special applications, custom IEC61131 compliant data types may be created by the user, 

which do not correspond to any CEA709 network type but should still be available as a data 

point on the L-INX automation server, in order to access the data point value from the Web 

interface or over XML as a parameter. Further, such data points can also be made persistent, 

which makes variables of such custom data types persistent. 

Most of the IEC61131 data types may be used as global variables on the device and the 

L-INX Configurator will be able to create a suitable register data point for the IEC61131 data 

type. Supported data types include custom enumeration types (a multi-state register with the 

required states will be created automatically), strings (a string data point with a maximum 

length of 128 characters will be built), structures and simple arrays. 

If such structured variables shall be mapped to a data point, which shall only be persistent to 

store the structure but no access to its elements are required in the data point interface  create 

a suitable register data point during the IEC61131 variable import. In this case the data size 

of custom structures cannot be determined automatically, so the L-INX Configurator does 

not know how to create a suitable user data point. As a workaround, the type name must 

contain the desired size of the data point in bytes, for example: MyStructuredType(UT16) 

will tell the L-INX Configurator to create an IEC61131 register of type ‘user’ with a length 

of 16 bytes, to hold the data for the IEC61131 structure defined in the logiCAD program. 

As an alternative, structures and arrays the logiCAD type definitions can be exported to the 

Configurator using structured text. The Configurator builds custom structured data point 

types in the logiCAD category out of the structured text definitions. In this case, the exact 

data size of a user register is determined by the structured data type. Structure members of 

the logiCAD types are represented as a tree of sub-data points. logiCAD arrays (like ARRAY 

[1..16] OF INT) are represented as a series of single data points where each data point 

represents one array element. Note, that the array in logiCAD can still be access by index. 
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To Use logiCAD Types in User Registers 

1. In logiCAD right-click on the library with the types that shall be exported and select 

Export code….   

 

 

2. In the export dialog choose ‘.ST’ as the export configuration, select the option single file 

and choose a target file (see Figure 108). Then click Export, which creates the structured 

text file. 

 

Figure 108: Export logiCAD types as structured text. 

3. In the Configurator go to the menu Tools → Manage Structured Types. 

4. In the dialog choose the type Category ‘logiCAD’. 

5. Click the speed button Load types from disk . 

6. In the dialog Import Types from Disk click on  .  

 

 

7. In the file selector dialog, choose the file type Structured Text ‘.ST’ and open the 

previously exported file. 

8. The available types in the structured text file appear on the left-hand side of the dialog. 

Transfer all listed types to the Configurator by clicking . Alternatively select specific 

types and click . Then click Close. 

9. In the Manage Structured Types dialog, the imported logiCAD types are now listed. 

Click Close. 

10. Now you are able to create a structured user register. For Custom Type choose one of 

the imported logiCAD structure types.  
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8.6.4 Using Persistent Data Points and Markers 

Persistent data points are data points on the device that hold their value even after power loss. 

In the IEC61131 program there is no difference in handling global variables connected to 

persistent data points or to non-persistent data points. When using global variables on the 

device resource that shall retain their values after a reboot, the respective data points need to 

be configured with the persistent flag in the L-INX Configurator. 

Global input variables marked as persistent, supply the IEC61131 program every time with 

the last received, valid data, even after a power failure. To enable this behavior, set the 

respective input data points persistent in the L-INX Configurator and download the data point 

configuration to the device. 

Global variables declared as marker can be used as input and output variable in IEC61131 

programs. LogiCAD is not able to distinguish markers from global output variables used in 

combination with the force update feature, see Figure 107. As a result it is not possible to 

create a global variables object holding markers automatically. The procedure as described 

in Section 8.5.1 is not able to decide when to create an output variable or a marker. Markers 

must be created manually by adding them to the global variables object and setting the 

physical address to %M. 

8.6.5 Using Retain Variables 

Retain variables can be used to maintain certain states or parameters of a program over a 

reboot in those variables, which cannot be kept in persistent data points. Typically, input 

variables (%I) will be marked as retain variables. For doing so check the RETAIN attribute 

in the variable declaration when creating or editing a variable as shown in Figure 109. 
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Figure 109: Declaring a retain variable. 

The retain attribute should be used in global variables and local variables on function plan 

only. Global variables on the device resource are managed by the I/O driver and must not use 

the retain attribute. Instead data point persistency (see Section 8.6.4) must be used for those 

variables. Furthermore, it is not recommended to mark local variables in function blocks as 

retain variables. 

The contents of retain variables are written to Flash storage every 5 minutes and when 

shutting down the device. This provides good compromise between write granularity for 

normal operation and ensuring Flash life-time. If the contents shall be written explicitly at a 

defined time, use the RetainCtl function block located in the logi.library/Data folder. 

Connect the store input (S) and set this input TRUE for one cycle to trigger writing retain 

data. Make sure to set the input back to FALSE after this cycle to avoid multiple consecutive 

writes. 

8.6.6 L-INX System Registers, System Time 

L-INX system registers, such as the system time or the CPU load, can be used within 

IEC61131 programs. Therefore, for each system input variable, a global input variable of 

type UDINT may be created within the IEC61131 program. Then, connections to the 

appropriate system registers are created manually with the L-INX Configurator. 

To use the system time within the IEC61131 program, connect the AtoDT converter (located 

in the StandardLibs->IEC61131-3_ (EXT) folder) to the global input variable that receives 

the system time. 

8.6.7 Code Protection 

There are 4 data points used for code protection. These data points, in combination with an 

adapted IEC61131 program, can be used to protect your 61131-Program Intellectual 

Property. Please contact LOYTEC sales for further information. 

8.6.8 Using Structured Data Point Members 

Some network technologies provide structured data points. Their types are defined by the 

network technology and are available in the Configurator. Those structure types can either 
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be used in logiCAD by implementing a technology converter (see Section 8.4.3) or by 

exposing the sub-data points of the respective structures. 

To Use Sub-Data Points in logiCAD 

1. In the Configurator, expand the structured data point and expose the desired sub-data 

points of its structure members to the PLC.  

 

 

2. Export the variables to logiCAD. The exposed structure members appear for example as 

‘/UR/mod1_Read.byte_0’ in the ‘User Registers’ global variables block. 

3. Export the types for the respective type category in the menu Tools → Manage 

Structured Types… . This opens the structured types management dialog. 

4. Choose the type Category, e.g. ‘Modbus’.  

 

 

5. Click the speed button Save to disk . 

6. In the dialog Export Type to Disk choose a Disk Repository Path and select the 

extension ‘.ST’ for structured text.  

 

 

7. Copy all listed types to the disk repository by clicking . Alternatively select specific 

types and click . Then click Save and exit the dialog. 

8. In logiCAD create a new library folder, e.g. ‘modbus_types’. 

9. Right-click on that new library and select Export/Import → Start ST Import. In the 

file dialog choose the previously exported structured text file. 

10. The type definitions are now available in the new library.  

 

 

8.6.9 BACnet Server Objects 

BACnet server objects provide additional functionality compared to other network 

technologies. The most important tasks in an IEC61131 program are: 

• Reading sensor data from BACnet input objects, 

• writing to commandable BACnet objects with a priority, 

• revoking values from commandable BACnet objects, 

• handling objects when out of service. 

The default data flow direction for a commandable BACnet object (e.g. AO) is input to the 

PLC (%I). This means its value is commanded over the BACnet network and the logic 
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processes the resulting value. The default for non-commandable BACnet objects (e.g. AI) is 

output (%O). This means the logic writes the value, which is read out of the object over the 

BACnet network. With this type of variables the BACnet objects are treated as variables of 

the IEC61131 program. 

When exposing local I/O to BACnet server objects, the BACnet objects represent the I/O 

values and the IEC61131 program behaves like a user from the network on those objects. 

Typically sensor values are connected to BACnet input objects (e.g. AI). To read the sensor 

value the PLC needs an input variable. Since the default data point direction is output, a 

separate access data point for the PLC must be created. For doing so, use the Add/Remove 

BACnet properties option from the context menu of the data point list and create a read data 

point for the Present_Value. Figure 110 shows an example, where the PLC uses the input 

‘/BAC/AI2.Present_Value_Read’ to get the sensor values from AI2. 

 

Figure 110: PLC with BACnet objects. 

BACnet output objects (e.g. AO) are connected to actuator I/Os. On those BACnet objects 

the PLC behaves like a user from the network and needs to write and revoke values at certain 

priority slots. For writing with a certain priority to a commandable object, a priority write 

data point needs to be created (see LINX Configurator User Manual [2], Section BACnet 

Configuration, Write and Read with Priority). This data point is configured with a BACnet 

write priority in the Configurator and used as an output in the PLC. The example in Figure 

110 writes with priority ‘4’ to AO1 over ‘/BAC/AO1_pri4’. 

To revoke values in commandable server objects, the SetValueState function block must be 

used. It is located in the Loytec_Support/Service folder. The I/O variable of the controlled 

BACnet object is connected to the Variable input of the function block. A Boolean signal 

needs to be connected to the Invalid input. When this input changes to TRUE, the value is 

revoked at the respective priority slot. When it remains TRUE in the next cycle the service 

function block is idle. Figure 110 shows an example, how to revoke a value in ‘AO1’ at 

priority slot ‘4’. 

With the out-of-service feature BACnet server objects can be decoupled from the senor and 

actuator I/O equipment. When taken out of service, the I/O variables of the PLC are then 

decoupled from the network. The input variable Present_Value_Read of an AI no longer 

tracks the sensor value but reflects the value set in the AI from a BACnet OWS. This holds 

true for all non-commandable BACnet objects. Writing to the priority output variable of an 

AO only updates the priority array but no longer drives the actuator. This holds true for all 

commandable BACnet objects. 

The out-of-service state is reflected in the data point status and can be accessed with the 

ValueState function block. This function block reads the value state and is used in a similar 

fashion as the SetValueState function block. 

8.6.10 Custom Serial Protocols 

A logiCAD program can implement simple custom serial protocols using the SerialComm 

function block. The logic program assigns the Baud rate settings for the protocol as well as a 

logical bus number. This bus number can be selected on the port configuration Web UI in 

order to activate the custom serial protocol on that port. 

Custom serial protocols with the following communication properties can be supported: 
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• ASCII protocol: The serial communication block works with strings that are transmitted 

and received. 

• Line-Oriented: Each command and reply is modeled as a text line. The line can be 

terminated by any combination of CR and LF. 

• Start/End Character: If not line-oriented, a start and end character can be specified to 

detect start and end of a frame. The end character must be escaped in the frame content. 

• Master/Slave: The serial communication block is a master, which sends requests over 

the serial port and expects slave(s) to respond. The serial communication block can also 

implement a slave, which receives requests and creates responses. 

• Addressing Information: If the serial protocol has more than one slave, each request must 

have address information, which selects a specific slave. Especially for RS-485 bus 

communication address information is required. Since frames sent out are also received, 

they need to be filtered out by address. 

To start the implementation of a custom serial protocol use the function block SerialComm 

located in the StandardLibs→Loytec_Support→Service folder. Add a bus number and 

communication settings as a string (e.g., „38400-8N1-X“) as shown in Figure 111. Best 

practice for an implementation is to use an SFC-based state machine. All necessary input and 

output signals are available on this function block. The minimum number of states is Idle, 

Rx, Tx. For a full specification of this block use the F1 help. 

 

Figure 111: Example for the SerialComm block. 

String processing may build commands from data point values and extract data from 

responses, which are written to data points. The data points should be user registers that are 

organized into a separate sub-folder for the custom serial protocol. 
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9 Firmware Update 

The L-INX and L-GATE firmware support remote upgrade over the network and the serial 

console. 

To guarantee that the device is not destroyed due to a failed firmware update, the firmware 

consists of two images: 

1. The fallback image, 

2. the primary image. 

The fallback image cannot be changed. Thus, if the update of the primary image fails or the 

image is destroyed by some other means, the fallback image is booted and allows reinstalling 

a valid primary image. When the device boots up with the fallback image, the all port LEDs 

are flashing red. 

Newer devices do not have a dedicated fallback image anymore. Instead, they keep the last 

working firmware image as a backup. If a firmware upgrade fails or renders the device 

unsuable in any other way, the last working firmware image is re-installed. 

The firmware image is distributed in a firmware ZIP archive that applies to all L-INX and L-

GATE models. 

9.1 Firmware Update via the Configurator 

The primary image can be updated using the Configurator. For this purpose, it is 

recommended to have the device connected to the Ethernet and to have a valid IP 

configuration (see Section 5.2). The Configurator must be installed as described in the LINX 

Configurator User Manual [2]. 

To Update the Firmware using the Configurator 

1. Start the Configurator from the Windows Start menu: Start → Programs → LOYTEC 

LINX Configurator → LOYTEC LINX Configurator. 

2. Select the menu: Connection → Connect to device. This opens the device connection 

dialog as shown in Figure 112. 
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Figure 112: Device connection dialog. 

3. In the connection dialog, enter the IP address of the device as well as the admin user’s 

password. The password can be changed via the Web interface. 

4. If the device uses other port settings than the standard settings or the device is operated 

behind a NAT router, adapt the HTTP(S) port accordingly. 

5. Click on Connect. 

Note: Alternatively, one can also connect via LNS. A firmware upgrade over an FT-10 channel, 

however, needs a lot more time to complete than over IP. 

6. Optionally, check for updates by selecting the menu Help → Check for updates …. 

This function checks for new firmware and Configurator versions. 

7. Select the menu: Firmware → Update …  

8. This opens the Firmware Update dialog as shown in Figure 113. Click on the button 

 and select the firmware image. 

 

Figure 113: Firmware Update dialog of the Configurator. 

9. Click on Start and observe the download progress. 
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10. When the download is complete, a dialog appears. Click OK. 

11. In the Firmware Update dialog, click Close. 

12. The device’s firmware has now been successfully upgraded. 

9.2 Firmware Update via the Web Interface 

The device’s firmware can also be upgraded using the Web interface. This option can be 

found in the Config menu under the Firmware item. For more details refer to the LOYTEC 

Device User Manual [1]. 

9.3 Firmware Update via the USB Port 

The device’s firmware can be upgraded using a USB memory stick. The LCD display 

provides a menu to select and perform the upgrade. Select Device Management »» USB 

Storage »» Firmware Update and choose the firmware file. For more details refer to the 

LOYTEC Device User Manual [1]. 
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10 Troubleshooting 

10.1 Technical Support 

LOYTEC offers free telephone and e-mail support for the L-INX product series. If none of 

the above descriptions solves your specific problem please contact us at the following 

address: 

LOYTEC electronics GmbH  

Blumengasse 35  

A-1170 Vienna  

Austria / Europe 

e-mail :  support@loytec.com 

Web : http://www.loytec.com 

tel : +43/1/4020805-100 

fax : +43/1/4020805-99 

or 

LOYTEC Americas Inc.  

N27 W23957 Paul Road 

Suite 103 

Pewaukee, WI 53072  

USA 

e-mail: support@loytec-americas.com 

Web: http://www.loytec-americas.com 

tel: +1 (512) 402 5319  

fax: +1 (262) 408 5238 

 

10.2 Packet Capture 

Please refer to the Troubleshooting Chapter in the LOYTEC Device User Manual [1] to learn 

more about packet capture on the LOYTEC device. 

 

mailto:support@loytec.com
http://www.loytec.com/
mailto:support@loytec-americas.com
http://www.loytec-americas.com/
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11 Application Notes 

11.1 The LSD Tool 

Please refer to application note “AN002E LSD Tool” for further information about the 

LOYTEC system diagnostics tool for the LINX-10X.  

11.2 Use of Static, Dynamic, and External NVs on a Device 

Please refer to application note “AN009E Changing Device Interface in LNS” for more 

information on the static NV interface, XIF files, device templates and the use of static, 

dynamic, and external NVs on LOYTEC gateway products. 
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12 Security Hardening Guide 

This guide contains security-relevant information for operating the product on IT networks. 

The information refers to the firmware version and the instructions found in the previous 

chapters of this User Manual. 

12.1 Installation Instructions 

Install the device over the Web interface: 

• Set up the basic device functions and protocol settings as described in Section 5.2. When 

connecting over the Web UI use https:// in the URL. 

• Set a secure password for the admin and operator accounts. 

• Disable the HTTP, FTP, and Telnet servers in the IP port configuration as described in 

the LOYTEC Device User Manual [1]. Note, that FTP and Telnet are disabled in factory 

defaults as of firmware 7.0.0. 

• Create a new HTTPS server certificate as described in the LOYTEC Device User Manual 

[1]. 

• Set a password for the “guest” user to protect information of the device info page from 

unwanted disclosure. 

12.2 Firmware 

The device is equipped with one piece of software. This is the firmware image and its related 

firmware version. The firmware is distributed as a downloadable file. The device can be 

upgraded by placing the firmware image onto the device using the procedure described in 

Chapter 9. The device firmware is signed by LOYTEC and its signature integrity is verified 

before the upgrade is allowed. 

12.3 Ports 

This Section lists all ports, which may be used by the device. The ports are default settings 

for their respective services. If not stated otherwise, the ports can be changed. 

Required Ports: 

• 443 tcp: This port is opened by the Web server and the OPC XML-DA server. It offers 

secure communication. Make sure the L-STUDIO deploy method is set to “loytechttps” 

and the Configurator as well as other clients use secure connection. 

• 1628 udp/tcp: This is the data exchange port for CEA-852 (LON over IP). It is required 

for the primary function of the device to exchange control network data between routers 

over the IP network. Each device needs this port open. The port can be changed. 
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• 1629 udp/tcp: This is the configuration server port of CEA-852. Exactly one device in 

the system needs this port open. Other devices register with the configuration server to 

form the IP-852 channel list. The port can be changed. 

• 47808 udp: This is the data exchange port for BACnet/IP. It is required for the primary 

function of the device to exchange control network data between routers over the IP 

network. Each device needs this port open. The port can be changed. 

Optional ports not necessary for the primary product function. They can be disabled as 

described in the installation instructions in Section 12.1: 

• 21 tcp: This port is opened by the FTP server. The port can be changed and disabled. 

• 22 tcp: This port is opened by the SSH server. The port can be changed and disabled. 

• 23 tcp: This port is opened by the Telnet server. The port can be changed and disabled. 

• 80 tcp: This port is opened by the Web server and the OPC XML-DA server. It should 

be disabled and HTTPS (port 443) be used instead. The port can be changed. 

• 161 tcp: This port is opened by the SNMP server. This port is disabled by default. The 

port can be changed. 

• 5900 tcp: This port is opened by the VNC server, if it is enabled. This port is disabled 

by default. The port can be changed. 

• 502 tcp: This port is opened, if Modbus TCP is configured in slave mode. This port is 

disabled by default. The port can be changed. 

• 3671 udp: This port is opened by KNXnet/IP, if KNX is enabled on the Ethernet 

interface. This port is disabled by default. The port can be changed. 

• 1630 udp/tcp: This port is used by the CEA-709 RNI and for the remote LPA. The port 

can be changed and disabled. 

• 2048 tcp: This port is opened by the logiCAD online test. It cannot be changed. The 

service can be disabled but the port will remain open. 

• 16028/16029 udp: These ports are opened for LIOB-IP on the device. These ports cannot 

be changed. They can be disabled. 

• 2002 tcp: This port is opened by the Wireshark protocol analyzer front-end. This port is 

disabled by default. The port can be changed. 

• 4840 tcp: This port is opened by the OPC UA server. This port is disabled by default. 

The port can be changed. 

• 5353 udp: This port is open for finding the device using mDNS names such as 

loytec.local. This port can be disabled. 

• 61000-62299 udp: This port range is used for IEC-61499 cross-communication between 

controllers. The ports are assigned automatically by the L-STUDIO programming tool. 

12.4 Services 

Required services: 

• CEA-852 (LON over IP): Primary function of the device. This service is in accordance 

with the standard ANSI/CEA-852-B. 

• BACnet/IP: Primary function of the device. This service is in accordance with the 

standard ANSI/ASHRAE 135-2010. 

• OPC XML-DA: This Web service provides access to data points over the OPC XML-

DA standard. 
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Optional services not necessary for the primary product function. They can be disabled as 

described in the installation instructions in Section 12.1: 

• mDNS: This service is used for finding the device via multicast DNS in order to establish 

initial communication. This allows using DNS names such as loytec.local in the Web 

browser. This service can be disabled. 

• HTTP: Web server. It provides a Web-based configuration UI. The Web UI can be 

disabled after setting up the device. The Web service is also used for the Configurator 

connection for configuration, firmware upgrade, and access to the log file. 

• HTTPS: Secure Web server. It provides a Web-based configuration UI using HTTPS. It 

is also used for a secure Configurator connection. 

• SSH: SSH server. It provides secure access to the device console menu over the network. 

• FTP and Telnet: The FTP and Telnet server is used for connection to the device by the 

Configurator for configuration, firmware upgrade, and access to the log file. On devices 

without SSH these services must be enabled during device configuration. 

• VNC: The VNC server can be used for remote access to the LCD display on devices that 

have it. The service is disabled by default. 

• Modbus TCP: A Modbus TCP server is running when Modbus TCP is operated in slave 

mode. In all other cases this service is not needed. 

• KNXnet/IP: A KNXnet/IP server is running if KNX is enabled on the Ethernet port. In 

all other cases this service is not needed. 

• RNI: This service provides the remote network interface (RNI) function. It is also used 

by the remote LPA feature. If these features are not needed the service can be disabled. 

• logiCAD online test: This service is used by the L-logiCAD programming tool for online 

debugging of IEC61131 programs. It is enabled by default on L-INX devices that have 

the IEC61131 logic kernel. The service can be disabled. 

• LIOB-IP: This service is used by the L-IOB host function to operate LIOB-IP I/O 

modules. This service is enabled by default on all L-INX devices. The service can be 

disabled. 

• OPC UA: This secure service provides access to data points over the OPC UA standard. 

The service is disabled by default. 

• SNMP: SNMP server. It provides network management information on the device used 

by standard IT tools. The service is disabled by default. 

• Wireshark front-end: The Wireshark protocol analyzer may connect to this service and 

retrieve online protocol analyzer logs. The service is disabled by default. 

• IEC-61499: This service is used by the IEC 61499 runtime for cross-communication 

between controllers. 

12.5 Upgrade Key Strength 

The secure services (HTTPS, SSH) rely on certificates to authenticate the device against the 

connecting client. This is key to prevent man-in-the-middle attacks. The device comes with 

pre-installed server certificates. It is recommended to upgrade the pre-installed certificate to 

an individual server-certificate and use stronger key length. 

• Server certificate (for HTTPS, OPC UA): Follow the instructions in the LOYTEC 

Device User Manual [1] Section 3.2.29 Certificate Management on how to upgrade the 

pre-installed X.509 server certificate to a custom, self-signed or CA-signed certificate 

with stronger key length. 
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• SSH key upgrade: If SSH is enabled it is recommended to upgrade the SSH key length. 

Refer to the LOYTEC Device User Manual [1] Section 3.2.28 SSH Server Config on 

how to upgrade your RSA key to 2048 bits. 

12.6 Logging and Auditing 

The device contains a log file, which can be read out over SSH or the Web server. This log 

contains information when the device started and when crucial communication errors occur. 

Other information such user log-on are not logged as they are not part of the primary services 

of this device. 

Logged events: 

• Time of the last power-on reset of the LOYTEC device. 

• Time and version of the last firmware upgrade. 

• Time when the device configuration has been cleared or the device was reset to factory 

defaults. 

• Commission of the CEA-709 node/router. 

• Static errors in the device and data point configuration. 

• System overload situations as one-time log messages since last power-on. 

• Crucial communication errors as they occur. 

• Logins and login failures. 

• Failed firmware upgrade attempts. 

12.7 Network Access 

Network access can be protected by using 802.1X port authentication (as of firmware 7.4.0) 

using EAP-TLS, PEAP, or TTLS. Unused Ethernet ports can be disabled. 

12.8 Password Protection 

Devices provide separate administrative (admin) and operative (operator) user accounts. 

Passwords are not stored, only a strong cryptographic hash (salted SHA256) thereof. Device 

login is protected by a login trap that blocks logins for 10 seconds after ten consecutive failed 

login attempts using different passwords to protect against brute-force password attacks. 

Initial password setting is enforced to use strong passwords. Without setting the initial 

password, the device functionality is locked down. Passwords can be up to 64 characters long 

and contain any printable UTF-8 character. 

To protect usage of the admin password, the admin user can create additional user accounts 

with an admin role. Those additional user accounts can be disabled as needed. Usernames 

can be up to 32 characters. The built-in user accounts can be disabled, if custom user accounts 

with those roles have been created. 

12.9 Encryption-At-Rest 

Client credentials required for operation (e.g., E-Mail client) are stored in encrypted storage 

using AES256-CBC with nonce. The secret encryption key is bound to the device and cannot 
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be accessed or read out of the device. Credentials can be exported or imported encrypted by 

a project password and PBKDF-2. 

12.10 Information Policy 

LOYTEC follows a policy for reporting, documenting an informing about potential security 

vulnerabilities and advisories: 

1) The LOYTEC Web site offers a mailing list subscription to receive security-related 

information in a timely manner. 

2) The LOYTEC Web site provides an interface to report any potential security 

vulnerabilities related to LOYTEC products. Incident reports can also be sent to 

security@loytec.com. A response will be sent with a trackable identifier. 

3) LOYTEC commits to providing security fixes for zero-day exploits within 96 hours after 

their discovery. All other security-related fixes will be made available in the next 

firmware patch within 30 days. 
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13 Specifications 

13.1 Physical Specifications 

13.1.1 LINX-102/103/112/113/202/203/212/213/215 and LGATE-902 

Operating Voltage 12 – 35 VDC or 12 – 24 VAC ±10 % 

Power Consumption typ. 2.5 W 

In rush current up to 950 mA @ 24 VAC 

Operating Temperature (ambient) 0C to +50C 

Storage Temperature –10C to +60C 

Humidity (non condensing) operating 10 to 90 % RH 

Humidity (non condensing) storage 10 to 90 % RH 

Enclosure Installation enclosure 107 mm wide, DIN 43 880 

Environmental Protection IP 40 (enclosure); IP 20 (screw terminals) 

Installation DIN rail mounting (EN 50 022) or wall 

 mounting 

13.1.2 LINX-12X/15X/22X, LGATE-95X 

Operating Voltage 24 VDC or 24 VAC ±10 % 

Power Consumption typ. 2.5 W 

In rush current up to 950 mA @ 24 VAC 

Operating Temperature (ambient) 0C to +50C 

Storage Temperature –10C to +60C 

Humidity (non condensing) operating 10 to 90 % RH 

Humidity (non condensing) storage 10 to 90 % RH 

Enclosure Installation enclosure 159 mm wide, DIN 43 880 

Environmental Protection IP 40 (enclosure); IP 20 (screw terminals) 

Installation DIN rail mounting (EN 50 022) or wall 

 mounting 
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13.2 Resource Limits 

13.2.1 L-INX Models 

Table 8 and Table 9 specify the resource limits of the different L-INX models. 

The BACnet object limit for general-purpose server objects refers to BACnet objects created 

manually that are typically used in gateway configurations. A second, higher BACnet object 

limit includes auto-created by L-STUDIO that are typically used in a PLC application. 

The terminal limit in the following tables defines the maximum number of usable L-IOB 

terminals on connected L-IOB I/O modules. 
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                           Model 

  

Limits 

1
0

2
/1

0
3
 

1
1

2
/1

1
3
 

1
2

0
/1

2
1
 

1
5

0
/1

5
1
 

1
5

3
 

1
5

4
 

Total number of data points 10,000 10,000 30,000 30,000 30,000 30,000 

OPC Tags 2,000 2,000 10,000 10,000 10,000 10,000 

User Registers 2,000 2,000 2,000 2,000 10,000 10,000 

NVs (static, dynamic) 1,000 1,000 2,000 2,000 2,000 2,000 

External NVs 1,000 1,000 2,000 2,000 2,000 2,000 

Alias NVs (ECS and legacy 

mode) 

1,000 1,000 2,000 2,000 2,000 2,000 

Address table entries/legacy 512/ 

15 

1000/ 

15 

1,000/ 

15 

1,000/ 

15 

1,000/ 

15 

1,000/ 

15 

LONMARK Calendar objects 1 (25 calendar patterns) 

LONMARK Scheduler objects 100 (max. AST configuration size 384KB, 64 data points per 

scheduler) 

LONMARK Alarm Servers 1 1 1 1 1 1 

BACnet objects (analog, 

binary, multi-state) general 

purpose 

n/a n/a n/a 1,000 2,000 2,000 

BACnet objects (incl. PLC)     6,000  

BACnet client mappings n/a n/a n/a 5,000 5,000 5,000 

BACnet scheduler objects n/a n/a n/a 100 100 100 

BACnet calendar objects n/a n/a n/a 25 25 25 

BACnet notification classes n/a n/a n/a 32 32 32 

BDT max recommended n/a n/a n/a 100 100 100 

Foreign devices max n/a n/a n/a 256 256 256 

KNX Communication Objects 

(per interface) 

250 250 1000 1000 1000 n/a 

Trend Logs 256 256 512 512 512 512 

Total trended data points 256 256 1000 1000 2000 2000 

Total aggregated size 200MB 200MB 60MB 60MB 200MB 200MB 

E-mail templates 100 100 100 100 100 100 

Math objects 100 100 100 100 100 100 

Alarm Logs 10 10 10 10 10 10 

Modbus data points 2,000 2,000 2,000 2,000 2,000 5,000 

M-Bus data points 1,000 1,000 1,000 1,000 1,000 n/a 

EnOcean data points 250 250 1,000 1,000 1,000 n/a 

SMI devices (per port) 16 16 16 16 16 n/a 

Connections (local) 1,000 1,000 2,000 2,000 2,000 2,000 

Connections (global) 250 250 250 250 250 250 

L-WEB Clients (concurrent) 32 32 32 32 32 32 

L-IOB Modules 8 8 24 24 24 24 

Terminal limit 200 200 600 600 600 600 

LWLAN-800 AP+Mesh max 

clients 

7 7 7 7 7 7 

Table 8: Resource limits of different L-INX models 
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                           Model 

  

Limits 

2
0

2
/2

0
3
 

2
1

2
/2

1
3
 

2
1

5
 

2
2

0
/2

2
1
 

Total number of data points 10,000 10,000 10,000 30,000 

OPC Tags 2,000 2,000 5,000 10,000 

User Registers 2,000 2,000 5,000 2,000 

NVs (static, dynamic) n/a n/a 1,000 n/a 

External NVs n/a n/a 1,000 n/a 

Alias NVs (ECS and legacy 

mode) 

n/a n/a 1,000 n/a 

Address table entries/legacy n/a n/a 1000/15 n/a 

LONMARK Calendar objects n/a n/a 1 (25) n/a 

LONMARK Scheduler objects n/a n/a 100 n/a 

LONMARK Alarm Servers n/a n/a 1 n/a 

BACnet objects (analog, 

binary, multi-state) 

750 750 750 1,000 

BACnet objects (incl. PLC)   2000  

BACnet client mappings 750 750 750 5,000 

BACnet scheduler objects 100 100 100 100 

BACnet calendar objects 25 25 25 25 

BACnet notification classes 32 32 32 32 

BDT max recommended 100 100 100 100 

Foreign devices max 256 256 256 256 

KNX Communication Objects 

(per interface) 

250 250 250 1000 

Trend Logs 256 256 256 512 

Total trended data points 256 256 256 1000 

Total aggregated size 200MB 200MB 200MB 60MB 

E-mail templates 100 100 100 100 

Math objects 100 100 100 100 

Alarm Logs 10 10 10 10 

Modbus data points 2,000 2,000 2,000 2,000 

M-Bus data points 1,000 1,000 1,000 1,000 

EnOcean data points 250 250 250 1,000 

SMI devices (per port) 16 16 16 16 

Connections (local) 1,000 1,000 1,000 2,000 

Connections (global) 250 250 250 250 

L-WEB Clients (concurrent) 32 32 32 32 

L-IOB Modules 8 8 8 24 

Terminal limit 200 200 320 600 

LWLAN-800 AP+Mesh max 

clients 

7 7 7 7 

Table 9: Resource limits of different L-INX models (cntd.) 
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13.2.2 L-GATE Models 

Table 10 specifies the resource limits of the different L-GATE models. 

 

                                    Model 

  

Limits 

 9
0

2
 

 9
5

0
/9

5
1
 

 9
5

2
 

Total number of data points 10,000 30,000 30,000 

OPC Tags 2,000 5,000 5,000 

User Registers 1,000 2,000 2,000 

NVs (static, dynamic) 1,000 2,000 2,000 

External NVs 1,000 2,000 2,000 

Alias NVs (ECS and legacy mode) 1,000 2,000 2,000 

Address table entries/legacy 512/15 1,000/15 1,000/15 

LONMARK Calendar objects 1 (25 calendar patterns) 

LONMARK Scheduler objects 100 (max. AST configuration size 384KB, 

64 data points per scheduler) 

LONMARK Alarm Servers 1 1 1 

BACnet objects (analog, binary, multi-state) 2,000 1,000 2,000 

BACnet client mappings 750 1,000 1,000 

BACnet scheduler objects 100 100 100 

BACnet calendar objects 25 25 25 

BACnet notification classes 32 32 32 

BDT max recommended 100 100 100 

Foreign devices max 256 256 256 

KNX Communication Objects (per interface) 250 1000 1000 

Trend Logs 256 512 512 

Total trended data points 256 1,000 2,000 

Total aggregated size 200MB 60MB 200MB 

E-mail templates 100 100 100 

Math objects 100 100 100 

Alarm Logs 10 10 10 

Modbus data points 250 2,000 2,000 

M-Bus data points 250 1,000 1,000 

EnOcean data points 250 1,000 1,000 

SMI devices (per port) 16 16 16 

Connections (local) 1,000 2,000 2,000 

Connections (global) 250 250 250 

L-WEB Clients (concurrent) 32 32 32 

L-IOB Modules n/a n/a n/a 

LWLAN-800 AP+Mesh max clients 7 7 7 

Table 10: Resource limits of different L-GATE models 
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13.3 Removable Media 

13.3.1 LINX-12X/15X/22X, LGATE-950/951 

 

SD Card microSD form factor, max 8GB, standard density or 

SDHC (no SDXC), optionally with or without partition 

table, uses first primary partition 

13.4 FCC Warning 

This device has been tested and found to comply with limits for a Class B digital device, 

pursuant to Part 2 and 15 of FCC Rules. These limits are designed to provide reasonable 

protection against harmful interference when the equipment is operated in a commercial 

environment. This equipment generates and radiates radio frequency energy and, if not 

installed and used in accordance with the user’s manual, it may cause interference in which 

case users will be required to correct interference at their own expenses. 

13.5 CE Warning 

This is a Class B product. In a domestic environment, this product may cause radio 

interference in which case the user may be required to take adequate measures. 
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15 Revision History 

Date Version Author Description 

2016-03-23 6.0 STS Re-organized User Manual structure, branched out 

common parts into LOYTEC Device User Manual and 

LINX Configurator User Manual. 

2016-10-19 6.1 STS Added new device models. Added license activation. 

2017-04-24 6.2 STS Added new device models. 

2017-12-20 6.3 STS Updated for firmware 6.3.0. 

2018-05-15 6.4 STS Updated for firmware 6.4.0. Limit changes for L-INX 

models. 

2019-05-15 7.0 STS Updated for firmware 7.0.0. 

2020-04-30 7.2 STS Updated for firmware 7.2.0. Removed old models LINX-

100/101/110/111/200/201/210/211 and LGATE-900. 

Documented LWLAN-800 client limitation. 

2021-01-29 7.4 STS Updated for firmware 7.4.0. Documented LRS232-802 

usage. Updated Chapter 12 Security Hardening Guide. 

2022-01-30 7.6 STS Updated for firmware 7.6.0. Section 5.2.5 LWEB-900 

VPN Enrollmen. Updated Chapter 12 Security Hardening 

Guide. 

2023-02-28 8.0 STS Updated for firmware 8.0.0. Documented BACnet/SC 

availability. 

2023-12-30 8.2 STS Updated for firmware 8.2.0. Documented that 

L-LOGICAD license is discontinued. Updated Section 

5.5. Added Section 5.6 Getting started with L-STUDIO. 

2025-07-30 8.4 STS Updated for firmware 8.4.0. Section 5.2.1: Added 

‘loytec.local’ method to find devices. Updated Chapter 12 

Security Hardening Guide. Section 13.2.1: Documented  

new limit for auto-generated PLC BACnet server objects. 

Documented terminal limit. 
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